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 مقدمه

های سیری  بونی سیوتی  معمولاً برری پوش(  VARs) 1های خودرگرسیوو  بردرریمدل

گورد. همچنون برری تحلول تاثوررت پویای رخ لالات تصادفی  زمانی مورد رس فاده قررر می

 بر روی سوت   م غورها نوز کاربرد درد.  

شییود. برری  رررئه می  VARهای  های مه  مدلدر ردرمه، توضییوحات مخ صییری رز وی گی

(  2006)  2کافلتورنود به عوتمی  VARتجزیه و تحلولمطیاععیه بورییی ر در زمونیه م انی  

رررئه  VARهای  ری در زمونه تجزیه و تحلول مدلمررجعه کنود که توضییوحات گتیی رده

 صورت زیر نوشت:تور  بهدر می  VARهای  درده رست. مدل

 (1)  

 در رینجا درری :  

 رز م غورهای وربت ه رست.  K * 1یک بردرر  

 رز م غورهای مت قل رست.  K * 1یک بردرر  

 های ضرریب رست که باید برآورد شود.وقفه  K*Kماتریس  

C   ماتریسK*d  .ضرریب م غورهای مت قل رست که باید برآورد شوند 

 
1 Vector Autoregression 
2 Lütkepohl 
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 نوز یک فرریند وریت نویز با مرخصات زیر رست: 

 (2)  

 افزارکار با نرم

   VARبرآورد یک مدل  

 ریجاد کنود. متور: VARباید رب در یک آبجکت   VARبرری تصریح یک مدل  

Quick > Estimate VAR 

تورنوید بیا بیاز شیییود. رع  یه می  VARرر رز منوی ریویوز طی کنوید تیا پنجره مربوب بیه میدل  

نوز بیه رین پنجره رسیییوید. پنجره    Enterدر نورر فرمیا  و کلویک گزینیه    varع یارت  تیایی   

 صورت زیر رست:به  VARهای مدل  رصلی و گزینه
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رر به   VARکنو . پنجره مربوب به مدل  شیییروی می  VARکاهش یاف ه    رب در با یک فرم

 صورت مناسب با مدل پر کنود:

رن خاب کنود )به عنور  مثال    VAR Taypeرر رز بخش    VARدر رب در نوی مدل   •

 (Standard VARروش 

تورنوید نمونیه مورد نرر خود رر رن خیاب کنوید. می  Estimation Sampleدر بخش   •

 تعدیل کنود.زمانی رر در صورتی که مایل باشود  رین دوره  

 وررد کنود. Endogenous Variablesرر در فولد   Kرهای وربت ه وعوتت م غ •

 رست. TB3و   ,M1, IPشامل    هدر رین مثال م غورهای وربت  •
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وررد کنوید. رین   Lag Intervals for Endogenous  شهیا رر در بختعیدرد وقفیه •

وقفه م غورهای وربتی ه    Rangجا شیود. در رینرطلاعات به صیورت جف ی وررد می

 رن خاب شده رست: 4یک تا  

1 4 

 4رین جفت عدد به رین معنی رسییت که برری تمام م غورهای وربتیی ه در سییمت ررسییت  

 شیود. هناامی که تصیریح مدلوقفه رز وقفه رین م غورها نوز به عنور  رگرسیور وررد می

VAR مریخ  شید، بر روی OK یب با رس فاده  رضیربرآورد ماتریس   ریویوز کلوک کنود تا

 رنجام دهد. OLSرز روش 

 نتیجه برآورد

 تصریح شده به صورت خورهد بود:  VARبرآورد مدل  
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رشیاره شید شیامل    VARطور که در بخش تکمول پنجره  هما  VARمدل تصیریح شیده  

(. همچنون مدل تصیریح شیده دررری  TB3و   IP  ،M1( رسیت )K=3سیه م غور وربتی ه )

(. P=4وقفیه برری م غورهیای وربتییی یه رسیییت ) 4تیا    1( و تعیدرد  d=1)  Cییک جز  ثیابیت 

 + Kpم غور متیی قل در هر سییه معادعه تصییریح شییده وجود دررد ) 13بنابررین تعدرد  

d=13).  
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رسییته همچنون   VARگر یک تصییریح معادعه  هر سیی و  رررئه شییده در رین بخش بوا 

ریویوز برری هر م غور متیی قل، ضییریب،  گر م غورهای متیی قل رسییت.ها نوز بوا ردیف

 کند.گزررش می  Tخطای رس اندررد و همچنون آماره 

دهد. رین ریویوز رطلاعات رضییافی بوریی ری در بخش پائون ن ایا ضییرریب رر نرییا  می

 :شودرطلاعات به دو بخش تقتو  می

برری هرمعیادعیه  OLSی بیه روش  هیای برآوردبخش رول خروجی خلاصیییه آمیاره •

 رست.

به عنور  یک کل رسیت.   VARخروجی نوز خلاصیه آماری سیوتی    م  بخش دو •

و معویارهیای    نمیاییعایاری   درسیییت،  هیامیانیدهکووررییانس بیاقی  دترمونیا رین آمیار  

 :و تعدرد ضرریب رست  یرطلاعات
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 های سیستم:نکاتی در زمینه محاسبات آماره

 شود:صورت زیر محاس ه می( بهSC( و شوررز )AICرطلاعاتی  آکائوک ) دو معوار   •

 

 در رینجا درری :

 

 رست. VAR ، تعدرد کل پاررم رهای برآوردی در مدلnکه  
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رسیی فاده    VARتور  بر ری مقایتییه و رن خاب وقفه بهونه مدل  رز معوارهای رطلاعاتی می

شیود  مقادیر بوری ر آ  ترجوح درده می تر هر معوار رطلاعاتی نتی ت بهکرد که مقادیر ک 

 تر رست.بونی بالاتر مدل با خطای ک و بوانار قدرت پوش

 در ایویوز 1برآورد یک مدل بیزین

 به منرور برآورد یک مدل بوزین متور:

Quick > Estimate VAR 

رر کلویک کنوید    Enterرر در بخش نورر فرمیا  تیایی  و دکمیه    varرر طی کنوید و ییا ع یارت  

 باز شود.  VAR Specificationتا پنجره  

 Bayesian، گزینه  VAR Specificationدر سیمت پ  پنجره    Var Typeرز بخش  

VAR  های  رر رن خاب کنود. همانند مدلVar  تورنود،  رسیی اندررد شییما در رین پنجره می

ها، م غور متی قل رر وررد کنود.  همچنون در بخش پائونی  قفهعوتیت م غورهای وربتی ه، و

تغوور   بدو تورنود نمونه رر مطابق نرر خود تغوور دهود یا آ  رر پنجره در سیمت پ  می

 باذررید.

 
1 Bayesian VAR 
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و   Prior typeرصییلی وجود دررده یکی    Tabدو   Var Specificationدر پنجره رصییلی  

ما رمکا  سیفارشیی کرد  تصیریم شیما رر رسیت که به شی   Prior specificationدیاری  

 1دهد.می

 
کند که شییما با رصییول روعوه  و رنوری مخ لف و تنرومات مرت ن آشیینا  بحث زیر در مورد رین تنرومات فرض می 1

 هت ود.
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 Prior Typeبخش  

هیایی برری محیاسییی یه  و همچنون گزینیه   Priorبرری تعوون نوی    Prior Typeبخش  

 شود.های روعوه رس فاده میماندهماتریس کوورریانس باقی

 

کییرکیی  نییورر  بییخییش  قیی ییوییل  گییزییینییه   Prior Typeری  هردر  رز  مییخیی ییلییفییی  هییای 

Litterman/Minnesota  ،Normal-Wishart  ،Sims-Zha Normal-Wishart   و ییا

Sims-Zha Normal-Flat  .برری رن خاب وجود دررد 

تورنوید ییک روش برری  می،  Normal-Wishartهیا نتییی یت بیه گزینیه  Priorبرری بقویه  

خورهود رین در صیورتی که می  مانده روعوه رر رن خاب کنود.برآورد ماتریس کوورریانس باقی

 Degreesماتریس کوورریانس برآورد شیده با درجه آزردی مدل تعدیل شیود، توک گزینه  

of Freedom Vorrection    .فعال کنود 
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 Prior Specificationبخش  

های روعوه رر با رخ صییا   توزیعدهد که  به شییما رجاره می Prior Specificationبخش 

بوش رز حید ییا ییک میاتریس روعویه رررئیه شیییده توسییین کیاربر تعوون    1رَبَرپیاررم رییک مقیدرر  

در کادر    Hyper-Parametersکنود. رگر شیما یک رَبَرپاررم ر رر رن خاب کنود، باید گزینه  

Type Prior Specification    .رن خاب کنود 

 Litterman / Minnesota Priorبخش  

تورنود رَبَرپاررم ر رر با رسی فاده رز   می  Litterman/Minnesota Priorبخش با رسی فاده رز  

 محاس ه کنود.    𝜆3و  𝜇1 ،𝜆1  ،𝜆2 پهار رسکاعر  

 

 
1 Hyper-Parameters 



 افزار ایویوزاقتصادسنجی کاربردی پیشرفته با نرم 

 

13 

 

𝜆1    رهموت نت ی نمونه و رطلاعاتPrior کندرر کن رل می 

 مثال تجربی 

برری نرییا  درد  شییووه برآورد بوزی و تفتییور آ  فایل کاری با مرییخصییات زیر در نرر 

گذرری  با رسیی فاده رز تفاضییل عااری   سییرمایه  VAR(2)باورید. هدف تخمون یک مدل  

(DLINVESTMENT( درآمییییید   ،)DLINCOME  مصیییییییرف و   )

(DLCONCUMPTION.رست )( برری2007)  2کوپلها توسن لاترین مجموعه درده 1 

 برآورد یک مدل بوزی مورد رس فاده قررر گرف ه رست.

 برری برآورد مدل بوزی رب در متور: 

Quick > Estimate VAR 

پنجره تصیییریح   بیاز کرد   بخش    VARبرری  در  گزینیه    VAR Typeرر طی کنوید. 

Bayesian VAR    رر رن خاب کنود. در بخشEndogenous Variables    نوز م غورهای

 زیر وررد نمائود:وربت ه رر به صورت  

dlincome dlinvestment dlconsumption 

 

بعید در   یعنی    Tabدر مرحلیه  رین پنجره  برری میدل    Priorنوی    Prior Typeدوم  رر 

VAR  در بخش   رن خاب کنود. ریویوز به صیورت پوش فرضPrior Type    بر روی گزینه

Litterman/Minnesota Prior     بییخییش   و  Initial Residual Covarianceدر 

 
 قابل مراهده رست.  ”wgmacro.WF1“های رین مثال در سایت ریویوز با عنور  درده 1

2 Lütkepohl 
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Options    گزینیهUnivariate AR Estimate  تورنوید نوی قررر دررد. شیییمیا میPrior   و

 گزینه برآورد روعوه کوورریانس رر رز منوها تغوور دهود.  

دهد. توجه درشی ه باشیود  تنرومات رَبَر پاررم ر رر نریا  می  Prior Specificationبخش 

رز تنرومات  م فاوت باشیید. در رین مثال   Priorتیی ه به نوی که تنرومات ممکن رسییت ب

 رر کلوک کنود.    OKد شد. سپس گزینه  پوش فرض رس فاده خوره

توسیین ریویوز در پنجره زیر نرییا  درده شییده رسییت. بخش بالایی    VARن ایا برآورد 

 دهد.  خروجی ن ایا رصلی برآورد رر نرا  می
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برآوردهیای جیدیید   Prior Typeدر بخش    VARرد  تور  بیا تغووررت در تنرومیات برآومی

 رر جایازین کرد:



 VARرگرسیون برداری  های خودمدلاول:  فصل  
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صیورت زیر برآورد تعدیل شیده به  VARکلوک کنود تا مدل بوزین   OKدر ردرمه بر روی  

 شود. 
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 مقدمه

سیازی شیررین شیرطی یک م غور  برری مدل ریویوز رکثر ربزررهای آماری مورد رسی فاده در

خورهند شید، با مدل  رند. ربزررهایی که در رین فصیل توضیوح درده  تصیادفی طررحی شیده

  دلایل م عددی برری  .سیییازی ورریانس شیییرطی یا نوسیییانات یک م غور م فاوت رسیییت

  ریتکممکن رست نواز به تجزیه و تحلول وجود دررد. رول  بونی نوسا  پوشسازی و مدل

 وربت ه بهبونی ممکن رسیت  دوم، فورصیل رطمونا  پوشباشیود.  دررریی و یا ررزش  درری  ناه

تور  فورصییل  سییازی ورریانس خطاها میطوری که با رسیی فاده رز مدل زما  باشییند، به

خطاها به درسی ی به درسی ی  در   ناهمتیانی ورریانس سیوم، بر رگر. دسیت آوردهتر رر بدقوق

به  1ARCHهای  . مدلدسیت آیدتورنند بهمی  یآوردگرهای کارآمدترسیازی شیود، برمدل

های شیرطی طررحی شیده رسیت. ورریانس ورریانسبونی  سیازی و پوشطور خا  برری مدل

م غور وربتیی ه به عنور  یک تابع رز مقادیر گذشیی ه م غور وربتیی ه و م غورهای متیی قل  

 وسیولهو به  معرفی شید(  1982) 2رنال توسین  ARCHمدل هایشیود. سیازی میمدل

ده در  ها به طور گتیی رمدل (توسییعه درده شیید. رین1986)  4( و تولور1986) 3سییلوبارل

های سییری زمانی ماعی رسیی فاده  های مخ لف رق صییادسیینجی، به وی ه در تحلولزمونه

 .  شودمی

سیازی نوسیانات در نرر گرف ه  برری مدل کهریویوز  موجود در  تصیریحاترز طوفی  در ردرمه  

 شود.شود مرور میمی

 
1 Auto Regressive Conditional Heteroskedatisticity 
2 Engle 
3 Bollerslev 
4 Taylor 
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  GARCHهای  مدل

 GARCH (1 , 1)مدل  

 کنو :شروی می  GARCHترین شکل  در رب در بحث خود رر با ساده

   (1)  

 (2)  

( به صورت تابعی رز م غورهای مت قل و جمله خطا  1مدل مواناون رررئه شده در معادعه )

بونی پوش بونی در یک دوره بر رسییا   ورریانس پوش  𝜎2جا که  بوا  شییده رسییت. رز آ 

معادعه ورریانس شیرطی مریخ    شیود.ناموده می  1رطلاعات گذشی ه رسیت، ورریانس شیرطی

 ری رست:( یک تابع سه جمله2شده در معادعه )

 𝛚جمله ثابت  •

هیا در  رطلاعیاتی دربیاره نوسیییانیات دوره ق یل کیه تحیت عنور  وقفیه مربع بیاقومیانیده •

𝝎𝑻−𝟏که با  شیودگوری میمعادعه مواناون رندرزه
نریا  درده شیده رسیت )جملات    𝟐

ARCH.) 

𝝈𝑻−𝟏آخر که با   شده دورهورریانس پوش بونی   •
 شود.می  نرا  درده 𝟐

رشیاره به جملات خودرگرسیوو مرت ه رول جملات    GARCH (1 , 1)در    (1 , 1)ع ارت  

GARCH    دررد )روعون رصیییطلاز رز سیییمت پ  در پررن ز( و جملاتARCH   مواناون

 ARCHم حرک مرت ه رول )دومون رصییطلاز رز سییمت پ  در پررن ز( رسییت. یک مدل  

 
1 Conditional Variance 
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بونی  رسیت که در آ  هو  وقفه پوش GARCHعموعی، یک حاعت خا  رز مریخصیات  م

 رست.  GARCH(0, 1)ورریانس در معادعه ورریانس شرطی وجود ندررد که هما   

گر  شیییود کیه نمیاینیده ییا معیاملیهرین خصیییوصیییویات رزلیب در زمونیه میاعی تفتیییور می

کننیده وررییانس رین دوره رر بیا تریییکویل ییک مویاناون وزنی رز ییک مویاناون بونیپوش

( و GARCHبلنیدمیدت )ثیابیت(، وررییانس پوش بونی شیییده رز آخرین دوره )جملات  

رگر ( رسییت. ARCHرطلاعات در مورد نوسییانات مرییاهده شییده در دوره ق لی )جملات  

گر  ن حرکت کند، معاملهبازده دررریی به صییورت زورمن رره در جهت سییمت بالا یا پایو

بنیدی  میدل همچنون بیا خوشیییهرین    .دهیدبرآورد وررییانس رر برری دوره بعیدی رفزریش می

خورنی دررد، در حاعی که تغووررت  آید، ه های ماعی به دست میکه رزلب در درده  نوسانات

 . تر خورهد بودبه دن ال تغووررت بزرگ  تبزرگ در بازده رح مالا

 GARCH (p , q)مدل  

 ( درش ه باشو :  3رگر در معادعه )

 (3)  

 دهند.م غورهای مت قل در معادعه مواناون رر نرا  می   tXکه در آ  

رگر وررییانس شیییرطی ییا رنحررف رسییی یانیدررد رر در معیادعیه مویاناون وررد کنوید، ییک میل 

GARCH-in-Mean    یاGARCH-M   ، مدل (.  1987خورهو  درشیت )رنال و همکارر  

ARCH-M های کاربردی ماعی که در آ  بازده مورد رن رار در یک  رزلب در برنامه رسیت
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ضیریب برآورد شیده بر    .شیودرسی فاده میمرت ن رسیت،     دررریی  رن راری  به ریتیک  بادررریی  

 بازگرت رست.-ریتک   رندرزه م ادعه  ی،رن رار  ریتک روی  

رز رنحررف رسی اندررد شیرطی و یا ورود ورریانس  ARCH-M ر رز مریخصیاتدو نوی دیا

 شرطی به جای ورریانس در معادلات زیر نرا  درده شده رست:

(4)  

(5)  

 1توزیعی  فرضیات

نواز به یک فرض در مورد توزیع شییرطی جملات  ARCH روعوه   تصییریحاتبرری تکمول  

 وجود دررد:   ARCH هایکار با مدلخطا رست. فروضی سه گانه معمولاٌ در هناام  

 توزیع نرمال )گاوسی(   •

  T-Student توزیع •

 )GED( 2توزیع خطای عمومی •

نمایی برآورد معمولاً با روش ماکزیم  درسیییت ARCH با توجه به فروض توزیعی، مدل

 شود.می

 
1  Distributional Assumptions 
2 Generalized Error Distribution 
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نرمال شییرطی، سییه  ماکزیم   با خطاهای    GARCH(1 ,1)به عنور  مثال، برری مدل  

 به صورت زیر رست:  tنمایی برری مراهده  درست

 (6)  

𝜎𝑡
 در یکی رز فرم های بالا مرخ  شده رست. 2

 صورت زیر رست:نمایی به، سه  عااری   درستT-Studentبرری توزیع 

(7)  

υجیا درجیه آزردی  در رین > ، زمیانی  T-Studentکنید. توزیع  رف یار دن یاعیه رر کن رل می  2

υکه   →  شود.  سمت توزیع نرمال نزدیک میکند، به مول می ∞

 درری :  GEDبرری فرض سوم  

(8)  

𝑟جا پاررم ر نرمال  در رین > درری توزیع نرمال   (GEDرسییت. توزیع خطایی عمومی ) 0

𝑟رست رگر   = 𝑟باشد و در صورتی که   2 <  ، دم کلفت خورهد بودGEDباشد توزیع  2
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نمایی و با رین ماکزیم  درسییتبا روش  ریویوز در ARCH هایفرض، مدلبه طور پوش

شیوند، صیورت نرمال توزیع شیده باشید به صیورت شیرطی توزیع میفرض که خطاها به

 شوند.برآورد می

 افزارکار با نرم

 های آرچ و گارچ رز متور زیر:برری تخمون مدل

Object > New Object > Equation 

شیده به صیورت زیر رن خاب نمائود  ری در رن های پنجره باز  رر رز نورر کرکره ARCHگزینه  

در رین پنجره مقدرر م وسین و ورریانس، توزیع خطا و نمونه برآوردی نوز رررئه شیده رسیت 

 که باید تکمول شود:
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 Mean Equationبخش  

رگر مریخصیه   باید مریخصیات معادعه مواناون رر وررد شیود. Mean Equationدر بخش 

ری رر در سیمت  باشید، باید آی   مناسیب رز منوی کرکره ARCH-Mرصیلی شیامل یک  

در رین حاعت ممکن رسیت بتی ه    .ررسیت بالا و سیمت ررسیت پنجره باز شیده رن خاب کنود

 رر رن خاب کنود.Log(Var) و یا      Std. Dev., Varianceبه درده خود گزینه  

 Variance Equationبخش  

 بخش معادله واریانس باید وارد شود.در این 
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 Modelبخش  

رر رز بخش   GARCH/TARCH، گزینده  GARCHهدای اتدددادانددارد  برای تخمین مدد 

Model  تر رز بیه رنوری پوچویدههیای موجود در رین بخش  رن خیاب کنوید. سیییایر گزینیه

توضیوحات آ  رررئه  ARCHشیوند که در بخش برآورد مربوب می GARCH مریخصیات

 خاهد شد.

رر مریییخ  کنود. به صیییورت پوش   GARCHو   ARCHباید تعدرد    Orderدر بخش 

ترین گزینه رین مورد آرچ رسیت که تقری اً پر رسی فاده 1گارچ و    1فرض رین مقادیر شیامل  

 رست.

باید تعداد اصطلاحات ناماقارن را در قسمت  اگر هدف برآورد یک مد  ناماقارن باشد،اگر

Threshold order    وررد نمیائوید. تنرومیات پوش فرض برری بخشThreshold order  

 در رین حاعت بر روی صفر قررر دررد.

 Variance regressorsبخش  

شیود.  فهرسیت م غورهای مورد نرر شیما مریخ  می  Variance regressorsدر بخش 

، ریویوز هموره شامل یک جز  ثابت GARCHهای  باید توجه درشت که به رس ثای مدل

 عنور  رگرسوو  ورریانس خورهد بود که شما نوازی به وررد کرد  آ  ندررید. به

 Restrictionsبخش  

رن خیاب می GARCH / TARCH رگر میدل میرر  میدلکنوید،   تورنوید پیاررم رهیای 

GARCH کنوید روش محیدود  دو  بیه  گزینیه .رر  رز  منوی یکی  کیه  رسییییت  رین  هیا 
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Restrictions  رر بیه IGARCH   پیاررم رهیای پیاییدرر رر بیه مجموی بیه ییک    کیهتغوور دهوید

دیار  کنیدمحیدود می رز گزینیه رسییییت کیه    Variance Target.گزینیه  دیار   یکی 

Variance Target رسییت که عملکرد پاررم رهای GARCH   زورشییرطی ررو ورریانس 

 .  کندمحدود می

 The Error Distributionبخش  

 Errorباید یک ورودی را اع منوی  ،   شددر ب برای اطاهابرای مشددخک دردن مرت توعی   

Distribution دنیددد مر)  مب  .اناخدداک  شیش  گزیندده  ، Gaussian  ،)Student’ tتوان 

 و ... را وارد دنید.  (GEDاطای  تعمیم یاماه  

 Estimation Optionsبخش  

به سادگی   .کندس رسی شما به تعدردی رز تنرومات برآورد رخ واری رر فرره  میایویوع د

ریویوز دس رسی    .ری رر به صورت دعخوره پر کنودها کلوک کنود و کادر محاورهروی گزینه

های هر به سییادگی گزینه. کندشییما به تعدردی رز تنرومات برآورد رخ واری رر فرره  می

Tab  خوره پر کنودرر کلوک کنود و پنجره باز شده رر به صورت دل.   

  (Backcastingپذیر )بازگشت   بخش

شیییود و همچنون  رسییی فاده می MA فرض، تغووررتی که در رب دری ررزیابیطور پوشبه 

پذیری  های برگریت، با رسی فاده رز روشGARCHورریانس روعوه مورد نواز برری جملات  

، ریویوز GARCHپذیر برری هناام محاسیی ه ورریانس روعوه برگرییت  .شییوندمحاسیی ه می
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کند و های معادعه مواناون رسیی فاده میماندهرب در رز مقادیر ضییریب برری محاسیی ه باقی

   .کندمحاس ه میرر  نمایی رز مقادیر روعوه    هموررسازسپس یک برآوردگر  

 GARC(1 , 1)مثال 

بدو  م غور متی قل در معادلات مواناون   GARCH (1،1) برری برآورد مدل رسی اندررد

 و ورریانس:

 9)  

  10)  

 د رر وررد کنود:شما باید قتمت های مخ لف مرخصات خو

 :  رر به صورت Mean Equation Specification بخش •

R C  

 پر کنود.  

وررد   GARCHرر برری تعدرد جملات  2و  ARCHرر برری جملات   1عدد  •

 کنود. در ردرمه متور:

GARCH > TARCH 

 رر کلوک کنود.

 رن خاب کنود.   ARCH-M termرا برای  Noneگزینه  •
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 رر بدو  تغوور باذررید. Variance Regressorsگزینه  •

 :ARCH(4)-Mبرری برآورد مدل  

  11 )  

 برری برآورد رین حاعت، پنجره رر به صورت زیر پر کنود:  

 معادعه مواناون رر وررد کنود.  •

وررد   GARCHرر برری تعدرد جملات  2و  ARCHرر برری جملات   4عدد  •

 .رر رن خاب کنود  GARCH (symmetric)گزینه  کنود. در ردرمه  

 رن خاب کنود.   ARCH-Mرر برری جملات   Std. Devگزینه  •

 وررد کنود. Variance Regressorsرر در بخش  DUMگزینه  •

پنجره فو  گزینیه   رز تکمویل  کنوید.    OKپس  بیا روش  ARCH هیایمیدلرر کلویک 

نرمال شییونده بر رسییا  رین فرض که خطاها به طور نمایی برآورد میماکزیم  درسییت

نمایی ظاهر خطی در تابع درسیییتشیییوند. رز آنجا که ورریانس به صیییورت زورتوزیع می

در خن وضیعوت، . شیودهای تکررر برآورد میشیود، تابع رح مال با رسی فاده رز رعاوری  می

 تورنود مقدرر رح مال رر با هر تکررر تغوور دهود.  می

های مرسییوم رگرسییوو  در  م رها و آمارهشییود، برآورد پاررهناامی که برآوردها همارر می

 .شودرررئه می   ARCH پنجره  
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های مورد رسی فاده برری  فرض، پنجره خروجی برآورد، نمونه برآوردی و روشه طور پوشب

محاسیی ه خطاهای رسیی اندررد ضییریب، جملات ورریانس روعوه و معادعه ورریانس رر نرییا   

همورر  ری با رس فاده رز پاررم ر  نمونهس پوشدهد. همچنون روشی برری محاس ه ورریانمی

λشده برربر با  =  در نرر گرف ه شده رست.   0.70

شییود: بخش بالایی خروجی رسیی اندررد  به دو بخش تقتییو  می  ARCHخروجی رصییلی  

 Variance"کند، در حاعی که بخش پایون، با برپتب  برری معادعه مواناون رر فرره  می

Equation"  ،شییامل ضییرریب، خطاهای رسیی اندررد ،Z-Statistics  و P-Values   برری

 βبا   GARCHو پارم رهای    αبا   ARCHضیییرریب معادعه ورریانس رسیییت. پارم رهای  

 شود.نرا  درده می
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ها در معادعه  ماندههای رگرسیوو  مورد باقیری رسی اندررد رز آمارهپایون خروجی مجموعه

در صییورتی که هو  م غور متیی قلی در معادعه مواناون وجود   .دهدمواناون رر رررئه می  

منفی    2Rدرر ن اشید. در مورد فعلی  ممکن رسیت معنی  2Rصیورت  ندرشی ه باشید، در رین

 شده رست.

 نکته پایانی 

GARCH  (βو    ARCHدر رین مثیال مجموی مقیادیر ضیییررییب   + α  تیا حید زییادی بیه )

ن وجه    . رینکه مفهوم آ  رین رست که شوک نوسانات کاملاً پایدرر رستیک نزدیک رست.  

   .شودرزلب در درده های ماعی با فرکانس بالا دیده می
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 مقدمه

 و  رسیت  نام قار  و  م قار   زیا   تابع  یک  بررسیا   1کورن ایل  رگرسیوو   در  پاررم رها برآورد

 کورن ایل  رگرسیوو . شیودمی  محاسی ه حدرقل مربعات  رگرسیوو   در  پاررم رها برآورد  مریابه

  متی قل   م غورهای  دخاعت  رمکا   معموعی،  رگرسیوو   مفروضیات  محدودیات  درشی ن بدو 

 رین و  کندمی فرره   رر  رن هایی  و  رب دریی  هایدن اعه  در وی ه به توزیع  هایقتیمت  تمام  در

 و  بلنید  هیادن یاعیه  بیا  هیایتوزیع  در  و  رسیییت  نرمیال  زور  خطیا  توزیع  کیه  زمیانی  رگرسیییوو 

  مدل  رین.  پردرزدمی  پاررم رها برآورد  با  رگرسیوو   ناهمانی وجود  با  همچنون  و  نام قار ،

 تجزیه برری  جامعی  روش به  تدریا به  شیید و  ( معرفی1978) 2باسییت  و کونکر  توسیین

  ت یدییل   مخ لف  هیایزمونیه  در  پیاسیییم،  م غور  زورخطی  و  خطی  هیایمیدل  أمیاری  تحلویل

  و جامع   دقوق  نااهی با  که رسیت  رین پندک  رگرسیوو   کارگوری به  رصیلی رناوزه.  گردید

  در   تنها نه  متی قل،  م غورهای  دخاعت  رمکا  تا  شیود رررئه  مدعی  پاسیم، م غور  ررزیابی  در

  رن هایی  و  رب دریی  هایدن اعه  در وی ه به  توزیع  هایقتیمت  تمام  در بلکه  ها،درده  ثقل مرکز

 و  ناهمتیانی  ورریانس  معموعی،  رگرسیوو   مفروضیات  محدودیت  با  رینکه  بدو   گردد،  فرره 

 پندک  رگرسیوو   در. پدیدرر شیود  ضیرریب برآورد  در  رف اده  دور  هایدرده  تأثورگذرر حضیور

 موزو   هیایمطلق بیاقومیانیده  قیدر  مجموی  نمود   حیدرقیل  رز  معموعی  رگرسیییوو   برخلاف

  3رنحررفات   مطلق  قدر  حدرقل  روش آ  به  که  شییودمی  رسیی فاده رعاو  پاررم ر برآورد برری

(LADگف ه )  (. 1978باست،   و  کونکر)  شودمی 

 

 
1 Quantile 
2 Koenker and Bassett 
3 Least Absolute Deviations 
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 افزارکار با نرم

 تور  رز متور:برری برآورد رگرسوو  کورن ایل در ریویوز می

Object  > New Object > Equation 

 یا

Quick > Estimate Equation 

در بخش زبا    QREGتور  رز طریق تای  ع ارت  به پنجره موردنرر رسیود. همچنون می

 ه کورن ایل در ریویوز دس رسی پودر کرد.  رفرما  ریویوز به پنج

 ود شد:هپس رز طی متور بالا وررد پنجره زیر خور
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فرم پنجره رگرسیوو  ریویوز برری برآورد رگرسیوو  کورن ایل به صیورت بالا خورهد بود. در  

و شییووه پر کرد    Optionو    Specificationره یعنی  رصییلی در رین پنج  Tabردرمه دو 

 آ  شرز درده خورهد شد.

 Specificationبخش  

بخش رول، که در بالا نرییا  درده شییده رسییت، برری   .دررری دو بخش رسییت.  Tabرین 

  برری برآورد و مرییاهدرت  ، Quantile Conditionalمرییخ  کرد  م غورها در تابع  

 .شودنمونه رس فاده می

همچنون شیما ممکن رسیت مایل باشیود م غورهای وربتی ه و رگرسیورها رر در بخش معادعه  

 وررد کنود. باید توجه درش ه باشود که ضرریب شما باید خطی باشند.

تورنود کورن ایل مورد نرر رر شییما می  Quantile to Eestimateدر بخش قابل ویرریش  

در نرر گرف ه رسییت که شییما   50/0ر رر وررد نمائود. ریویوز به طور پوش فرض رین مقدر

در آ  وررد کنود )توجه درشیی ه باشییود که مقادیر   1تورنود هر مقدرری بون صییفر و  می

 ممکن رست باعث مرکلاتی در برآورد شما شود(. 1خولی نزدیک به صفر و 

( و Cتعریف کنود که با یک مقدرر ثابت ) Y تورنود یک تابع م وسیین شییرطی رر برریمی

مریاهده نمونه برآورد  235برری کل    LADشیود. برآورد کنده  گوری میرندرزه  X سیری  

 دهد.رر رنجام می
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 Estimation Optionsبخش  

 با رسیی فاده رز رین پنجره بالا قابل تغوور رسییت. Quantile بوریی ر تنرومات رگرسییوو 

های سیییمت پ  پنجره کن رل روش برری محاسییی ه کوورریانس ضیییرریب رر رررئه گزینه

دهد که یک سیییری وز  برری برآورد وزنی تعوون کنود و دهد که به شیییما رجازه میمی

 .روش محاس ه برآوردها رر مرخ  کنود

 Quantile Regression Optionsبخش  

 برری مراهده به صورت زیر رست: Quantile Regression Optionsبخش 
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تورنوید روش محیاسییی یه  در پنجره بیالا شیییمیا می  Coefficient Covarianceدر بخش  

 Bootstrapو ییا    Huber Sandwichهیا شیییامیل کووررییانس رر رن خیاب کنوید. رین روش

resampling    رسیت. به صیورت پوش فرض در ریویوز روشHuber Sandwich    رن خاب

 شده رست.

ا ق ل رز درده هدهی کنود.  تورنود برری مریاهدرت خود وز شیما می  Weightsدر بخش   

 Scalar Sparsityشییوند. در بخش  برآورد با رسیی فاده رز رین مرییخصییات، ت دیل می

ییا کووررییانس    bootstrapبرری     تنرومیات دیاری برری محیاسییی یه کووررییا  وجود دررد.

رن خاب کنود. رع  ه در صییورتی که    Siddiquiو یا    Kernelمعموعی ممکن رسییت گزینه  

رن خاب شیده باشید در بخش روش   Huber Sandwichبرری محاسی ه کوورریانس روش  

 فعال رست.  Kernelتنها گزینه  

 Bootstrap Settingsبخش  

ری کوورریانس، سیمت ررسیت رین پنجره برری  در منوی کرکره   Bootstrapهناام رن خاب

شیییمیا    Methodدر بخش    .کنیدتغوور می Bootstrap هیایی رز گزینیهررررئیه مجموعیه

اناخداک دنیدد  Bootstrap  رز پهیار  روشتورنوید یکی  می . این چهدار رو  شددددامد  را 

Residual  ،XY-paiR  ،MCMB      و     MCMB-A   رسییت که در ریویوز به صییورت

 قررر دررد.    XY-pairپوش فرض بر روی گزینه  
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قررر دررد. گزینه   No. of obs و   Replicationsدر بخش پایونی رین پنجره دو گزینه  

Replications       تورنوید به  قررر دررد کیه شیییمیا می 100بیه صیییورت پوش فرض بر روی

نمونیه  Bootstrap برری تنرومیات    No. of obs مقیدرر دعخوره خود تغوور دهوید. گزینیه  

هیای هیایی رز رنیدرزهنمونیه  رین بخش خیاعی بمیانید ریویوزرگر   گورد.مورد رسییی فیاده قررر می

وجود دررد که مریخ  نمود  حج    یشیورهد .کندهای رصیلی رر رسی  میدهمریابه در

، به وی ه برری  یترممکن رسیت ن ایا دقوق  ،های روعوهتر رز دردهکوپک   Bootstrapنمونه 

 (. 2005  1)کوینکر،  ، توعود کندهای بزرگنمونه

 رر تکمول کنود. Outputدر یک ماتریس گزینه    Bootstrapبرری ذخوره ن ایا   

منحنی تصیادفی منقطع باید   کنند.دو مورد آخر، توعود تعدرد رعدرد تصیادفی رر کن رل می

ری رسی فاده کنود تا توعود کننده رعدرد تصیادفی مورد خود توضیوحی باشید. رز منوی کرکره

 
1 Koenker 
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با رسیی فاده رز تنرومات پوش فرض برری رن خاب توعود   ریویوز  نرر خود رر رن خاب کنود.

   .کندری رر رره رندرزی میکننده رعدرد تصادفی، منوی کرکره

فرض، رگر روعون بار رسیت که شیما یک بوت رسی را رر برری یک معادعه درده  به طور پوش

خاعی خورهد بود. شییما ممکن رسییت ررزش عدد    Seed شییده رنجام می دهود،  بخش 

به  EViews رررئه نریده باشید،  رگر درنه روعوه   صیحوح خود رر در صیورت دعخوره رررئه کنود.

روعوه با معادعه ذخوره  Seedمقدرر رین  . کند رر رن خاب می Seedطور تصادفی یک مقدرر  

رسییی فیاده    Seedخورهید شیییده بیه طوری کیه بیه طور پوش فرض برآورد بعیدی رز همون  

رگر می خورهود رز  دهد که ن ایا رر دوباره تکررر کنود.کند که به شما رین رمکا  رر میمی

وررد کنود یا    Seedدیار رسیی فاده کنود، به سییادگی یک مقدرر رر در قتییمت    Seedیک  

 .تصادفی جدید بتازد  Seedیک مقدرر   ریویوز رر فرار دهود تا  Clearدکمه  

 Estimation Outputبخش  

های خود رر خود رر رررئه کنود و گزینه Quantile هناامی که شیما مریخصیات رگرسیوو 

کلویک کنوید تیا معیادعیه خود رر برآورد  OK تورنوید بر روی دکمیهریید، میریییخ  کردهم

با تعدرد زیادی رز مریاهدرت   Bootstrappingبه جز حاع ی که شیما در حال رنجام  . کنود

 هت ود، ن ایا برآورد باید در مدت کوتاهی نمایش درده شود.

( و م غور  Yف مورد زذریی )مثال زیر یک تابع مصییرف با م غور  وربتیی ه مواناون مصییر

 مراهده رست.  235که شامل  (رستXدرآمد خانورر ) مت قل
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جیا رز دهید. در رینهیای برآورد شیییده رر نمیایش میقتیییمیت بیالای خروجی وی گی درده

برری محاسی ه ماتریس کوورریانس رسی فاده رسیت. همچنون در    Huber Sandwichروش

رسی فاده   15744/0و وز     Hall and Sheatherگزینه   Method Bandwidthبخش 

 شده رست.

 Tدر بخش پایئون نوز مقدرر ضییریب، عرض رز م در، رنحررف رسیی اندررد و همچنون آماره  

د بالا، درآمد خانورر با توجه به درر بود  رگرسیوو  رررئه شیده رسیت که در موربرری معنی

 95بوری ر رسیت در سیطح   96/1شیده رسیت و رز   85/17مربوب به آ  که    Tمقدرر آماره 

 درری بر مواناون مصرف موررد زذریی درش ه رست.درصد رطمونا  رثر مث ت و معنی

 رست.  Pseudo R-Squaredهای خوبی بررزش مدل رز جمله  تر شاخ در بخش پائون
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گزینه دیاری رر رن خاب   Bootstrappingبرری محاسی ه کوورریانس به جای    ممکن رسیت

 Estimationکلوک کنود تا پنجره باز شود، سپس   Estimateکنود. رب در بر روی گزینه 

Options    .در ردرمیه   رر کلویک نمیائویدMCMB-A    برری محیاسییی یه ضیییررییب کووررییانس

ریش دهوید. در نهیاییت برری دیید  تغووررت  رفز  500رن خیاب کنوید. تعیدرد تکرررهیا رر نوز بیه  

 رر کلوک نمائود.  OKدر ن ایا در ن وجه تغووررت بالا، گزینه  

 

 

 Xش رنحررف رسی اندررد م غور  و همچنون کاه Tرگرپه رین تغووررت، سی ب رفزریش آماره  

 شده رست رما رین رخ لاف تاثور قابل توجهی بر روی مدل ندرش ه رست.
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 مقدمه

ریویوز یک رربن آسیا  برری تعوون، برآورد و کار با ن ایا یک سیوتی      1بخش فضیای حاعت

ری رز کنید. ریویوز طوف گتییی ردهری هتییی نید رر فرره  میکیه تیک ییا پنید معیادعیه پوییا

کند که  بونی رر فرره  میو سیایر ربزررهای پوش  3همورر کرد   2ها، فول ر کرد ،مریخصیه

طوف کند.  شیده در فرم فضیای حاعت کمک می تصیریحهای پویا  ا سیوتی  به شیما در کار ب

 هایهای سیری زمانی، رز جمله مدل رگرسیوو  خطی کلاسوک و مدلری رز مدلگتی رده

ARIMA  های خاصیی رز مریخصیات فضیای حاعت نوشی ه شیود و تورند به عنور  نمونهمی

سیازی م غورهای  برری مدلهای فضیای حاعت در ردبوات رق صیاد سینجی  . مدلبرآورد شیود

درآمد    4گوری، مریاهدرت گ  شیده،نامطلوب رز جمله رن راررت )منطقی(، رشی  اهات رندرزه

کار گرف ه شییده ه  درئمی، رجزری زورقابل مرییاهده )پرخه و روند( و نرغ زور بتییامدی ب

ک اب   14تور  به فصییل های فضییای حاعت میدر زمونه مدلجامع  رسییت. برری مطاععه  

دو مزیت رصییلی  ( مررجعه کرد.  1989ک اب هاروی )  4و  3( و فصییول  1994)  5همول و 

دهد  ، فضیای حاعت رجازه میحاعت وجود دررد. رول  یک سیوتی   پویا در فرم فضیایبرری 

شیوند( به شیناخ ه می نوز  )که به عنور  م غورهای حاعت  زورقابل مریاهدهکه م غورهای  

تور  با رر میی فضییای حاعت  هادوم، مدل شییوند.  قابل مرییاهده و در کنار آ  محاسیی ه

(  Bucyرسیی فاده رز یک رعاوری   بازگریی ی قوی شییناخ ه شییده به عنور  فول ر کلمن )

دیار رعاوری   فول ر کیاعمن برری محیاسییی یه  کیاربرد    . رز جملیه موررد  کرد  تجزییه و تحلویل

 
1 State Space 
2 Filtering 
3 Smoothing 
4 Missing Observations 
5 Hamilton 
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هیای ، میدلARMA Gaussianهیای هیای محیدود برری میدلهیای دقوق و نمونیهبونیپوش

ARMA  )و شاخ   پند م غوره )بردرر( های پندگانه و علل پندگانهMIMIC.رست )  

 افزارکار با نرم

رفزرر ریویوز رنوری مخ لف ربزرر تخصیصیی رر برری تعوون و بررسیی مریخصیات فضیای  نرم

ها  های برآورد فضیای حاعت، دیدگاهObjectکند. همانند سیایر  حاعت برری شیما فرره  می  

ها رسییی ن ا  و تعوون  های بورییی ری رر برری بررسیییی ن ایا برآورد، رنجام آزمو روش و

 کند.  های  ریویوز فرره  میObjectمرخصات و رس خرر  ن ایا به سایر  

 تعیین یک مدل فضای حالت در ایویوز

کند.  های فضییای حاعت تک و پند معادعه رر مدیریت میری رز مدلریویوز طوف گتیی رده

های کوورریانس و شیررین با کن رل دقوق بر مریخصیات معادلات سیوتی  ، ماتریسشیما  

   .کنودروعوه  رین موررد رر کن رل می

فضییای حاعت    Objectروعون گام در تعوون و برآورد یک مدل فضییای حاعت، ریجاد یک  

 رست. متور:  

Object > New Object > Sspace 

رر در بخش نورر    sspaceتورنوید ع یارت  ن میرر رز نورر ربزرر رصیییلی تعوون کنوید. همچنو

کند  و پنجره فضیای حاعت  فضیای حاعت ریجاد می  Objectیک  ریویوز فرما  تای  کنود.  

ترین کار رین رست دو روش برری تعوون مدل فضای حاعت وجود دررد. سادهکند.  رر باز می

ده کنود تا به شیما در  رسی فا ریویوز )خودکار(  Auto-Specification ""های  که رز وی گی
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هیا کمیک کنید. رز بخش منوی فضیییای  هیای رسییی یانیدررد برری رین میدلریجیاد برخی رز فرم

های تخصیصیی باز محاورهرر رن خاب کنود.    Proc > Define State Spaceحاعت متیور  

 توضوح درده خورهد شد.   Auto-Specificationخورهد شد  که در بخش  

فضیای حاعت رر رز یک فایل م نی موجود وررد   تصیریحتوجه درشی ه باشیود که می تورنود 

فضییای حاعت نمایش درده شییود،  تصییریحاتکلوک کنود تا   Spec بر روی دکمه.  کنود

رر رن خاب کنود. بخش بعدی   ... Insert Text File سیپس کلوک ررست کنود و  گزینه  

Object  دهدوح میفضای حاعت رر به طور کلی توض. 

 تصریح معادلات حالت

و ییک معیادعیه حیاعیت مع  ر رسیییت.   "STATE@" ییک معیادعیه حیاعیت حیاوی کلمیه کلویدی

 :توجه درش ه باشود که

به  ریویوزدرشیی ه رز آنجا که  رر هر معادعه باید نام منحصییر به فرد م غور وربتیی ه   •

کند، شیما  ریجاد نمی  هاحاعتی برری های کارری رز فایلصیورت خودکار مجموعه

( رسییی فیاده  هیاسیییری  رز  )زور  در فیاییل کیاری موجود  Objectتورنوید نیام ییک  می

وربتی ه معادعه سیوانال و  یا  معادلات حاعت ممکن رسیت شیامل م غورهای    کنود.

   رین م غورها ن اشد.وقفه  

هر معیادعیه حیاعیت بیایید در وقفیه ییک دوره زمیانیط حیاعیت، خطی بیاشییید. زور خطی   •

ری زمانیط  های تکررر همزما  و وقفیه پنید دورهیا وجود حاعت  1ها،حاعتبود  در  

 کند.حاعت یک پوام خطا رر ریجاد می

 
1 States 
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و ضیرریب ناشیناخ ه باشیند    متی قلمعادلات حاعت ممکن رسیت شیامل م غورهای   •

 .و همچنون در رین عناصر زور خطی باشد

علاوه بر رین، معادلات حاعت ممکن رسییت شییامل یک خطای رخ واری یا مرییخصییات  

رگر هو  خطا یا ورریانس خطایی وجود ندرشی ه باشید، معادعه حاعت   ورریانس خطا باشید.

 ت در جزئواتشییود. مرییخصییات سییاخ ار خطی مدل های فضییایی حاعقطعی فرض می

"Errors and Variances" شرز درده شده رست. 

 هامثال

مرییخ     AR(2)زیر، یک خطای زورقابل مرییاهده  رر با یک فرریند  1دو معادعه حاعت

 کند:  می

@state sv1 = c(2)*sv1(-1) + c(3)*sv2(-1) + [var = exp(c(5))] 

@state sv2 = sv1(-1) 

 

 ، رز نرر ضیریبAR(2)و    C(2)رز نرر ضیریب،  SV1 برری AR(1)  در معادعه رول وقفه

C(2) توجه درشی ه   شیود.رسیت. همجنون مریخصیه ورریانس خطا به مربع پررن ز درده می

 شود. تعریف می  SV1 به صورت وقفه SV2 باشود که معادعه حاعت برری

 :به طور مرابه، معادلات حاعت زیر نوز مع  ر هت ند

@state sv1 = sv1(-1) + [var = exp(c(3))] 

@state sv2 = c(1) + c(2)*sv2(-1) + [var = exp(c(3))] 

@state sv3 = c(1) + exp(c(3)*x/z) + c(2)*sv3(-1) + [var = exp(c(3))] 

 
1 Two State Equations 
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 با ررنش رست.  AR(1)که یک گام تصادفی و یک  

 :معادلات حاعت زیر مع  ر نوت ند

@state exp(sv1) = sv1(-1) + [var = exp(c(3))] 

@state sv2 = log(sv2(-1)) + [var = exp(c(3))] 

@state sv3 = c(1) + c(2)*sv3(-2) + [var=exp(c(3))] 

 

معادلات حدرقل یکی رز شییرریطی که در بالا ذکر شیید )به ترتوب: ع ارت م غور   جارز آ 

اعیت( رر نق  ری رز م غورهیای حی حیاعیت وربتییی یه، زور خطی بود  حیاعیت، وقفیه پنید دوره

 کنند، بنابررین مع  ر نوت ند.می

 مشاهدات/ معادلات سیگنال

به طور پوش فرض، رگر تصیریح معادعه به طور خا  به عنور  معادعه حاعت با رسی فاده رز 

با آ  به عنور  یک مریاهده یا معادعه   شیناسیایی نریود، ریویوز  "STATE"کلمه کلودی  

 وانال ممکن رسییت به صییررحت با کلمه کلودیمعادلات سیی   .سییوانال رف ار خورهد کرد

"@SIGNAL" های خا  معادعه سیوانال به صیورت زیر شیناسیایی شیود. برخی رز جن ه

 رست:

 د.نباش  یم غورهای وربت ه معادعه سوانال ممکن رست شامل ع اررت •

  یر فعلی یا م غورهای سیوانال باشید معادلات سیوانال ممکن رسیت حاوی مقاد •

 ( مررجعه کنود(.1989)برری مطاععه بور ر به هاروی )

در   شیذ   خطی باشیند. زور خطی  ،های ه  زما معادلات سیوانال باید در حاعت •

 کند.  ها، یک پوام خطا ریجاد میحاعت
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و ضیرریب ناشیناخ ه    متی قثلمعادلات سیوانال ممکن رسیت دررری م غورهای   •

 باشد و در رین عناصر زور خطی باشند.

ت سیوانال ممکن رسیت شیامل یک خطای رخ واری یا مریخصیات ورریانس خطا  معادلا

 شود که قطعی رست.باشد. رگر خطا یا ورریانس خطا وجود ندرش ه باشد، معادعه فرض می

 هامثال

 های زیر مع  ر هت ند:مثال

log(passenger) = c(1) + c(3)*x + sv1 + c(4)*sv2 

@signal y = sv1 + sv2*x1 + sv3*x2 + sv4*y(-1) + [var=exp(c(1))] 

z = sv1 + sv2*x1 + sv3*x2 + c(1) + [var=exp(c(2))] 

 

 های زیر مع  ر نوت ند:مثال

log(passenger) = c(1) + c(3)*x + sv1(-1) 

@signal y = sv1*sv2*x1 + [var = exp(c(1))] 

z = sv1 + sv2*x1 + z(1) + c(1) + [var = exp(c(2))] 

 

معیادلات حدرقل یکی رز شیییرریطی که در بالا ذکر شییید )به ترتویب: وقفیه م غور   جارز آ 

کننید، بنیابررین  حیاعیت، زور خطی در م غور حیاعیت، ترکویب م غور سیییوانیال( رر نق  می

 مع  ر نوت ند.
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 کار با نرم افزار

ها و مدل فضییای حاعت ممکن رسییت بتییوار پوچوده باشییند رما ریویوز با رررئه ررهنمایی

 پوررف ه تا حد زیادی رین کار رر برری کاربرر  ساده کرده رست.   تنرومات

کلوک نمائود.    Specificationو سیییپس گزینه    Viewبرری شیییروی کار بر روی گزینیه  

 نمای مرخصات زیر رررئه خورهد شد:  

 

 رست.   Specification  قتمتبخری آشنا در    Text Screenگزینه  

رسیت.  وف م ن سیاخ ار مریخصیات فضیای حاعت  توصی   Coefficient Descriptionگزینه  

به عنور  توربع خطی م غورهای  رسییت که   𝑦𝑡و   𝛼𝑡+1م غورهای سییمت پ  به ترتوب 

 شود.  بوا  می 𝛼𝑖حاعت  
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به دررری   ARMAXم غور    به عنور  مثال مطابقت دررند.ضیییرریب  با   عناصیییر ماتریس  

  زیر رست:  شرز ضرریب

 

توضییوحات م ن ماتریس کوورریانس خصییوصییوات    Covariance Descriptionبخش 

 کوورریانس زیر رست:   تصریحدررری   ARMAX به عنور  مثال فضای حاعت رست.
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 مشخصات خودکار

  "Auto-Specification"ربزرر   برری کمیک در ریجیاد ییک وی گی فضیییای حیاعیت، ریویوز

کنوید بیا رسییی فیاده رز ییک  کنید کیه نمیایش م ن رر کیه رز ییک میدل مریییخ  میفرره  می

Dialog  کند. رین ربزرر در صییورتی که مدل شییما یک رگرسییوو  رسیی اندررد با ریجاد می

های ضیرریب تصیادفی ثابت، بازگری ی و پندگانه باشید و یا خطاهای شیما دررری  وی گی

 باشند، ممکن رست بتوار مفود باشد.   ARMA ساخ ار کلی

 زمانی که شما متور: 

Proc > Define State Space 

رول برری    Tabکنید.  رر بیاز می  Tabرر رز منو رن خیاب کنوید. ریویوز ییک پنجره بیا بیا سیییه  

هر سیپس م غور وربتی ه رر وررد کنود و  توصیوف بخش رصیلی رگرسیوو  رسی فاده می شیود. 

تورنود گزینه  رر وررد کنود. شیما می که دررری ضیریب ثابت یا بازگری ی رسیتوری  رگرسی 

COEF  تورنود در پایون، شما میمرخ  کرد  ضرریب ناشنا  رن خاب کنود.    رر رر برری

جا، مریخصیات یک ع ارت  . در رینرر برری خطاهای خود مریخ  کنود ARMA سیاخ ار

 مرخ  شده رست.  LOG(PASSENGER) رر برری ARMA (2,1) ساده
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Tab    ،تصیادفی هتی ند  هایی که دررری ضیرریب برری رضیافه کرد  رگرسیوو دوم پنجره بالا

.  های مناسیب رر در هر یک رز پهار فولد ویرریش وررد کنودرگرسیوو . شیودرسی فاده می

،  AR (1)هیا رر بیا هر ترکو ی رز مویاناون ثیابیت،  دهید تیا رگرسیییورریویوز بیه کیاربر رجیازه می

 گام تصادفی یا گام تصادفی با ررنش رن خاب کنود.  

نهیاییت   بون بیه شیییمیا رجیازه می  Auto-Specificationسیییوم پنجره    Tabدر  دهید 

  Tab. بر روی سیاخ ارهای ورریانس رسیاسیی برری مدل فضیای حاعت خود رر رن خاب کنود

های مخ لف ماتریس کلوک کنود و بون گزینه  Specification Varianceسوم با عنور  

Identity  ،Common Diagona  ،Diagonal    و ییاGeneral (Unrestricted)    کلویک

دهد معادعه سییوانال و معادلات حاعت رر به همچنون به شییما رجازه می  Tabکنود. رین 

 صورت کوورریانس خطای زور صفر درش ه باشود.  
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محدود رسیت، شیما    بوش رز حد  Auto-Specificationمریخصیات پری و انی شیده توسین  

رس فاده کنود و سپس  رصلی    تصریحرر به عنور  یک ربزرر برری ساخ ن   هامی تورنود رز آ 

   رر برری توصوف مدل خود ویرریش کنود. تصریح

 مدل فضای حالت  برآورد

که مریخصیات شیما   کنود  دیوو تا  کنودحاعت رر مریخ     یمدل فضیا  ک یکه    یهناام

دکمه    یبرآورد، به بر رو  پنجرهباز کرد    ی. برررسییتبرآورد    آمادهدرسییت رسییت، مدل  

Estimate ای و  دوکن  ک ودر نورر ربزرر کل  Proc > Estimate دورر رن خاب کن  . 
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دهید کیه نمونیه برآورد، بیه شیییمیا رمکیا  می هیای برآورد، ریویوزObjectهمیاننید سیییایر  

سیییازی و ضیییرییب کووررییانس، حیدرکثر تعیدرد تکررر، تحمویل همارریی و هیای بهونیهروش

 رعاوری   برآورد رر تعوون کنود.  

رسییت، رما شییما   sspace  ، BFGSدر بخشObjectسییازی پوش فرض برری بهونهروش 

رری  رر رن خاب کنود. ب OPG–BHHHو یا   Newton-Raphsonهای ممکن رست گزینه

بون روش پوش فرض،  بیه شیییمیا رجیازه می دهید    ریروش مرحلیه  1زورمنطقی،  برآورد

Dogleg   وLine    .یکی رر رن خاب کنود 

فرض    وررییانس در منوی Covariance Methodروی    بر  Ordinaryپوش  ، معکو  

سیازی رر زورمنطقی رنجام دهود،  رسیت. رگر شیما بهونه  Information Matrixری  کرکره

رسی فاده کنود.   Hessian - Observed مریاهده شیده با رن خاب Hessian تورنود رزمی

 
1 Non-Legacy Estimation 
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اشییید، در زور تنرومیات پوش فرض بیایید شیییروی خوبی برری مورجیه بیا رکثر مریییکلات بی 

 صورت تنرومات رر تغوور دهود.رین

 نکته مهم

 دو مورد رساسی در هناام برآورد مدل وجود دررد:

رگرپیه روش فول ر کیاعمن در ریویوز بیه طور خودکیار تمیام مقیادیر گمریییده در   •

نوازمند آ  رسییت که نمونه برآورد شییما دررری   کند، رما ریویوزنمونه رر ردرره می

 یک پووس ای باشد و شکافی بون مراهدرت وجود ندرش ه باشد.  

ی وجود ندرشیی ه باشیید، هنوز باید برآورد هو  ضییرریب ناشییناسیی  تصییریحرگر در   •

sspace    رنجام دهود  کاعمنخود رر برری رجرری فول ر. 

 ورد رررئه خورهد شد:  رر کلوک کنود، پنجره برآ OKزمانی که شما گزینه  
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جدید هتیی ند و ممکن رسییت نواز به بحث درشیی ه باشییند. ، های خروجیبرخی رز بخش

بخش پیایون رطلاعیات رضیییافی در مورد مقیادیر گ  شیییده رر در برآورد فرره  می کنید.  

گوری رح مال رسی فاده  مریاهدرت رح ماعی گزررش تعدرد ورقعی مریاهدرت که در شیکل

. رین عدد )که در محاسی ه معوارهای رطلاعات مورد رسی فاده قررر  دهدرر نریا  می  شیودمی

« که در بالای صییفحه نمایش درده می شییود، Included Observationsمی گورد( رز »

زیرر   کندهخار  می  ،مریاهدرت رر رز محاسی ه رح ماعی  ی رزیک ریویوز  گاهیم فاوت رسیت، 

د. تعدرد مریاهدرت حذف شیده در  تمام معادلات سیوانال دررری مقادیر گمریده هتی ن

"Missing Observations"    .گزررش شییده رسییت"Partial Observations"   تعدرد  

حذف شیده رسیت رر برخی معادلات  برری رما رر    شیامل می شیوند  رر که رح مالاً  یمریاهدرت

ری رسیت نریا  دهنده تعدرد کورورریانس های روعوه  "Diffuse  Priors" و  دهدنریا  می
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رر نرا    قادر به حل آ  نوتت و برری آ  نوازی به مقدرردهی روعوه کاربر نوتت  ریویوزکه 

 .  دهدمی
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 مقدمه

های تددری عمانب ی رماار شویای اقاصددادی و مالب اتددا اد  اع مد رو  رایج برای مطالعه

( و یا 𝐴𝑅های اود رگرتدیونب های اطب اع جمله مد ها یا به صدورت مد اتدت. این مد 

( مورد بررتب  𝑀𝑆توئیچینگ  -های غیر اطب ماردوف( و یا مد 𝑀𝐴میانگین ماحرک  

(، دوانت و 1972تدوئیچینگ برای اولین بار توتدک دوانت  -گیرند. مد  ماردوفقرار مب

مطرح و توتدعه داد     1989در تدا    2( معرمب شدد و توتدک همیلاون1973   1و دوانت  گلدملد

در مد  غیر اطب مر) این اتدددت ده رماار  شدددود.  شدددد و به مد  ترییر ر یم شدددناااه مب

های مخالف ترییر میکند.  ماریری ده قرار اتت مدلساعی روی آن صورت گیرد در وضعیت

مد  ماردوف بر اتدا  مد  چراه دسدو و دار همیلاون، ده چراه را به ونوان مرایند دو 

ع وا   ترییر  حالت با ترییرات ر یم تصدادمب مشدخک درد، گرماه شدد  اتدت. دلی  اتدا اد  ا

ای اع عمان معین دارای  ر یم به این دلی  اتدت ده مقک ماریر تدیاتداب ممکن اتدت در دور 

 ای دیگر رماار دیگری اع اود  نشان دهد.یک رماار و مرآیند باشد و در دور 

رست.   10رفزرر ریویوز رین فصل در ررت اب با معرفی و کاربردهای منوی سوئوچونگ در نرم

هیا و کیاربرد هر ییک رز رین منوهیا در برآورد روش رفزرر، منوهیا و قیابلویتبیا نرمدر بخش کیار  

سیوئوچونگ شیرز درده خورهد شد. در پایا  نوز منابعی پورنهای برری مطاععه بور ر رررئه 

 شده رست.

 
1 Goldfeld and Quandt 
2  Hamilton 
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 افزارکار با نرم

 برری رسود  به پنجره سوئوچونگ رب در متور زیر رر رز منوی طی کنود:

Quick > Estimate Equation 

 Methodری  رر در نورر کرکره  Switching Regressionسیپس مطابق شیکل زیر گزینه  

 رن خاب کنود:

 

برری مریخصیه رصیلی رگرسیوو  سیوئوچونگ  روعی   پنجره باز شیده دو زبانه وجود دررد.

برری  های رن خاب شییده  هایی برری تغوور وی گیشییامل گزینه  یدومو    شییودرسیی فاده می

شیامل سیه بخش رسیت   Specificationصیفحه   .های محاسی اتی برآورد رسیتکن رل جن ه
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جا تمرکز بر  رسیت که در رین تنرومات برآوردمریخصیات معادعه، مریخصیات سیوئوچونگ و  

 دو بخش رول رست:

 

رهیای  (( رب یدر و بیه دن یال آ  م غوtYجیا )در بخش رول بیایید م غور وربتییی یه )کیه در رین

دررند )در  هایی که ضییرریب زور م غور  رگرسییوو ((.  tXشییود )در رینجا )متیی قل وررد می

 .ذکر شوندفولد دوم  باید در    (tZجا )رین

  ( Regime Sspecific Error Variances)خطیای خا  ریی  ورریانس    تور  گزینیهمی

در ریی  سییوئوچونگ باشییود توک    1در صییورتی که مایل به بررسییی ناهمتییانی ورریانس

 بزنود.

های  گاهی ممکن رسیت که شیما مایل باشیود رز یک رگرسیوو  پویا با رضیافه کرد  وقفه

برری بررسییی خودهم تیی ای   ARم غور وربتیی ه به عنور  م غور متیی قل شییامل جز   

 باشود.

 
1 Heteroskedasticity 
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 Switching Specificationبخش  

 ر رست:به صورت زی  Switching Specificationبخش پنجره  

 

 .کندمرخصات ریی  رر کن رل می  Switching Specificationبخش 

به شییما رجازه می دهد بون سییوئو  سییاده و مارکوف    Switching Typeری  نورر کرکره

 یک مدل سوئوچونگ ساده رسترفزرر ریویوز  بر روی نرمتنرو  پوش فرض  کنود.  رن خاب  

پوش فرض  کنود.    وررد Number of Regimesها رر در قتییمت  شییما باید تعدرد ریی 

با بوش   سوئوچونگ های  رفزرر بر روی دو ریی  قررر دررد. باید درنرر درشت برآورد مدلنرم

 رز پند ریی  ممکن رست  دشورر باشد.

ریی     1های رضیافی رر برری رح مالات زور شیرطیممکن رسیت مایل باشیود که رگرسیوو 

)برری سییوئوچونگ سییاده( یا ماتریس رح مال رن قال ریی  )برری ریتییک زور شییرطی  

هایی  در رین بخش رین رسییت که درده   نک ه مه  مارکوف سییوئوچونگ( رر تعوون کنود.

تعوون    tکیه رح میال رن قیال ییا ریی  برری دوره    tهیای رح میاعی در دوره  برری رگرسیییوو 

   فایل قررر گورد.  Work Fileکنود باید در دوره زمانی  می

 
1 Unconditional Regime Probabilities 
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 Optionبخش  

بر روی   برری تغوور   یهیایگزینیه  Equation Estimationرز پنجره    optionبیا کلویک 

نمایش  به صیورت زیر های مخ لف محاسی ات  تغوور و کن رل جن ه  ،مریخصیاتها،  وی گی

 شود.می  درده

 Switchingبخش  

شیییکیل زیر ممکن رسیییت برری تعوون رح میالات روعویه  و ییا مطیابق    Switchingبخش  

 .هرگونه محدودی ی برری بردرر رح ماعی ریی  یا ماتریس رن قال رس فاده شود

 

نواز به مقادیر پوش فرض برری   SSAR ررزیابی رح مال در مارکوف سییوئوچونگ و مدل

ریی  به شیما رمکا     روعوه  رح مالاتردیف    .( دررد"رح مال روعوه"های فول ر شیده )رح مال

رر   User-Specifiedگزینیه  گر . ررین مقیادیر رر رن خیاب کنویدتعوون  دهید تیا روش روعویه  می

دهید کیه خودتیا  رح میالات روعویه رزی  رر ریویوز بیه شیییمیا رین رمکیا  رر می   رن خیاب کنوید،

 وررد نمائود.
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 Coefficient Covariance Optionsبخش  

 و  Broyden  ،Fletcher  ،Goldfarb    رهای رح مال رر با رسی فاده رز روشپاررم ریویوز 

Shanno (BFGS)  یب با رسی فاده  ربه طور پوش فرض، کوورریانس ضیر .کندبرآورد می

 .شودمحاس ه میرست    1منفی  مراهدرت  تصحوح شده رزکه معکو  هرون     .d.fرز

به منرور   به ریویوز Method Covariance ریهمچنون شیما می تورنود رز منوی کرکره

یا کوورریانس قوی  (OPG) هریون دسی ور دهود.، محصیول بورونی روش شیوب رسی فاده رز

و شیوب ها تریکول می   Hessian هوبر سیفود رسی فاده کنود که سیاندوی  رر با رسی فاده رز

 .  شودرس فاده می  d.fبرری حذف تصحوح   Adjustment checkbox d.fگزینه    .دهد

 Starting Value and Iteration Optionsبخش  

های رسی اندررد برری تنرو  حدرکثر تعدرد تکررر شیامل زمونه Iteration Control  بخش 

های  رز تنرومات برآورد خود رز گزینه ریویوزبه طور پوش فرض،  .  ل همارریی رستوو تحم

رر برری نمایش مقادیر   Display settings  تورنود گزینهکند. شیما میرسی فاده می  عمومی

 .خود رن خاب کنود  برآورد شدهخروجی   برریشروی و سایر تنرومات برآورد در بخش بالا 

  ها پاررم ر  روعوه رر برری کن رل تنرو  برآوردهای  Starting valuesشما می تورنود بخش 

ممکن  لی دررند و های محهای رگرسییوو  سییوئوچونگ رزلب ریرییهده کنود. مدلرسیی فا

ربزررهای گوناگونی برری رن خاب مقادیر   ریویوزآنها دشیورر باشید بنابررین  رسیت برری برآورد

 دهد.روعوه رررئه می

 
1 Corrected Inverse of the Negative of the Observed Hessian 
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 Start Methodبخش  

 که شامل:  به شما رجازه می دهد یک روش رساسی   Start Methodبخش  

EViews Supplied 

0.80 x EViews Supplied,  

0.5 x EViews Supplied 

0.3 x EViews Supplied 

Zero, User-Supplied 

 

  رن خاب کنود.  Starting Valueبرری رست رر  

 بخشیا    (OLS)  مربعات سییاده  حدرقلرز برآورد ضییرریب   شییده در ریویوز های رررئهروش

به طور دعخوره به صیفر تنرو    AR ضیرریب  .کنندها رسی فاده میبرآورد  رینرز   یمریخصی 

 .می شوند
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 Randomized Estimatesبخش  

دهد که  به شییما رین رمکا  رر می Randomized Estimatesدو فولد روعوه در بخش  

رر رن خاب    Start methodهای رررئه شیده در بخش مقادیری تصیادفی رر بر رسیا  روش

مریخ     Iterationsهمچنون ریویوز به صیورت تصیادفی تعدرد تکرررها رر در بخش   .کنود

 .شوندبا بالاترین مقدرر رح مال به عنور  مقادیر روعوه رن خاب میضرریب کند.  می

شیود(، ریویوز، به طور برری مقادیر پوش فرض )یعنی مورردی که توسین کاربر تعوون نمی

کند و ق ل رز رن خاب به رین مجموعه مقادیر شییروی تصییادفی توعود می 25پوش فرض،  

کنید. بیه طور پوش فرض،  تکررر رر رصیییلاز می 10مجموعیه بیه عنور  مقیادیر شیییروی، هر 

وجود ندررد. همچنون علاوه   user-suppliedتصیادفی بود  مقادیر رررئه شیده در حاعت  

 تورنود بر رسا  ضرریب برآورد نهایی نوز تصادفی کنود.  بر مقادیر روعوه، می

مقادیر شیروی تصیادفی با رن خاب به رین مقادیر برآورد شیده در دوره مورد بررسیی و رضیافه  

درده شیده توسین رنحررف رسی اندررد ضیرریب نهایی رن خاب    Random Scaleکرد  مقادیر  

ریویوز به طور   .شیوندشیود. برآوردها با بوری رین رح مال به برآوردهای نهایی ت دیل میمی

 دهد و باید توسن کاربر رنجام باورد.رر رنجام نمیپوش فرض رین مورد  

 Optimization Optionsبخش  

برری    Optimization Methodری در منوی ریویوز گزینه  تورنود رز نورر کرکرهشیییمیا می

 های مخ لف مطابق شکل زیر رن خاب کنود:روش
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مجنون شیییما  برری برآورد پاررم رها رسییی فاده کنود. ه BFGSتورنود رز روش  شیییما می

نورر    Newton-Raphsonو ییا    BFGS  ،OPG – BHHHهیای  تورنوید رز روشمی در 

 رس فاده کنود.   Optimization Methodری  کرکره

رمکیا  می   Step Methodدر همون بخش گزینیه   هیای  دهید کیه گزینیهبیه شیییمیا 

Marquardt   ،Dogleg     و یاLine Search  .رر رن خاب کنود  
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 مقدمه

شیامل یک گروه معادلات حاوی پاررم رهای ناشیناخ ه رسیت. سیوتی   ها رر   1سیوتی  

های پند م غوره برآورد کرد که وربتیی ای م قابل  تور  با رسیی فاده رز تعدردی رز روشمی

  .بون معادلات در سوت   رر در نرر باورند

 شکل عمومی یک سوت   به صورت زیر رست: 

𝑓(𝑦𝑡, 𝑥𝑡, 𝛽) =  𝜖𝑡 

نوز بردرری رز م غورهای متیی قل رسییت.   𝑥𝑡بردرری رز م غورهای وربتیی ه و  𝑦𝑡جا  در رین

نوز ضیرریب پاررم رهای معادلات رر   𝛽نوز جملات رخلال در هر معادعه رسیت.   𝜖𝑡همچنون  

 دهد.نرا  می

دهد. رویکرد رول برآورد های برآورد پاررم رهای سیوتی   رر رررئه میریویوز تعدردی رز روش

رویکرد دوم رین رسیت که پاررم رهای معادلات به طور . جدرگانه هر معادعه سیوتی   رسیت

برآورد شیییود. رویکرد همزمیا  بیه شیییمیا رجیازه می دهید  همزمیا  مجموعیه و کیامیل 

هایی مطابق با هم ت ای  دهود و رز روشهایی بر روی ضرریب در معادلات قررر  محدودیت

که هم تی ای بون رجزر  ها به ورسیطه رینرین روشدر بون رجزری رخلال رسی فاده کنود.  

کننید تور  رین رر دررنید کیه کیارری مجیان ی بیاشییینیده  خطیای معیادلات مخ لف رر عحیای می

شیما می    . همچنونیعنی دو خاصیوت سیازگاری و کارریی رر به طور همزما  دررر هتی ند

بونی  تورنود پاررم رهای یک سوت   معادلات رر برآورد کنود و سپس یک مدل برری پوش

 .زر در سوت   ریجاد کنودهای م غورهای درو سازی ررزشیا ش وه

 
1 System 
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وجود ک سییوتیی   برری ررزیابی پاررم رها  برری رسیی فاده رز ی  یدر حاعی که مزریای مهم

تر رز همه، رگر شیما رز یکی رز معادلات موجود در  مه .  ها بدو  هزینه نوتی ندآ رما  دررد،  

معادعه  تک  های  رسی فاده رز روش  ید بارسی فاده نکنود و پاررم رهای خود رر بارر  سیوتی    

برآورد کنود که برآوردی ضیعوف خورهد بود. ح ی رگر رز روش سیوتی می رسی فاده کنود  

رند به بقوه معادلات نوز توبازه  ممکن رسیییت ضیییعوف بود  برآورد یکی رز معادلات می

های توضیوحی رز م غور متی قل بود   سیرریت کند. یکی رز فرو  کلاسیوک و بتیوار مه ،

ممکن    و   شیودمیمعادلات همزما ، رین فرض نق   های  سیوتی  . در  رسیت رخلالجز   

هتی ند. در ورقع، با فرض درشی ن   رخلالهای توضیوحی، تابعی رز جز  برخی رز م غوررسیت 

ی  ی رول، م غور وربتی ه معادعهری، علاوه بر م غور وربتی ه معادعهدو معادعهیک سیوتی    

رین هم تییی ای جز  رخلال بیا بیاشییید.  ی رول میدوم نوز تیابعی رز جز  خطیای معیادعیه

 .معروف رست  1همزمانیم غورهای توضوحی در رق صادسنجی به متاعه  

 2های معادلات همزمانروش

 کند:  های زیر برآورد میپاررم رهای یک سوت   معادلات رر با رس فاده رز روشریویوز 

 (OLS) 3حدرقل مربعات معموعی  .1

 4معادلات رگرسوو  وزنی  .2

    (SUR) 5های به ظاهر زورمرت ن رگرسوو  .3

 
1 Simultaneous Problem  
2 System Estimation Methods 
3 Ordinary Least Squares 
4 Equation Weighted Regression 
5 Seemingly Unrelated Regression 
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 ( 2SLS)  1ریحدرقل مربعات دو مرحله .4

 2ری وز حدرقل مربعات دو مرحله .5

 ( 3SLS) 3ری مرحله حدرقل مربعات سه .6

  (GMM) 4 گر اورهای تعمو  یاف هروش  .7

 ( ARCH) 5ورریانس ناهمتانی شرطی رتورگرسوو .8

 (OLSحداقل مربعات معمولی )

کنید بیه هیا رر برری هر معیادعیه رر حیدرقیل میرین روش مقیدرر مجموی مربعیات بیاقومیانیده

رگر پنون   شییود.طوری که برری هر یک رز پاررم رهای سییوتیی   محدودی ی رعمال می

محدودی ی وجود ندرشیی ه باشیید، رین روش با تخمون رز هر معادعه با رسیی فاده رز حدرقل  

 .( یکتا  رستOLSمربعات معموعی )

 معادلات رگرسیون وزنی 

رین روش توضوحی برری ناهمتانی ورریانس بون معادلات م قابل با حدرقل کرد  مجموی 

عادعه، معکو  ورریانس معادلات برآورد های معادلات وزنی رسییت. وز  ممجذور باقوماده

رین روش در صیورتی  شیود.شیده رسیت و رز برآورد پاررم رهای زور وزنی سیوتی   حاصیل می

 
1 System Two-State Least Squares 
2 Weighted Two-Stage Least Squares  
3 Three-Stage Least Square  
4 Generalized Method of Moment 
5 Autoregressive Conditional Heteroskedasticity 
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تیک   OLSکیه محیدودی ی بر روی معیادلات م قیابیل وجود نیدرشییی یه بیاشییید بیا ن یایا روش  

 ری برربر رست.معادعه

   (SUR) های به ظاهر غیرمرتبط رگرسیون

، همچنون به طور زور رسییمی به عنور  (SUR)به ظاهر نامرت ن    هایروش رگرسییوو 

نوز شیناخ ه می شیود، یپاررم رهای سیوتی   رر رر بررسیا    1رگرسیوو  پند م غوره یا زعنر

کنید. همچنون  نیاهمتیییانی وررییانس و هم تییی ای پویاپی بون رجزری رخلال  برآورد می

 تریک فرم کلی رسیت. ریویوز  برآوردهای ماتریس کوورریانس معادلات سیوتی   بدو  وز 

SUR هیای معیادعیه بر روی دهید تیا محیدودییتکنیده رین رمر رجیازه میبونی میرر پوش

 .پاررم رها نوز وجود درش ه باشد

 (2SLSای )حداقل مربعات دو مرحله

( یک نتیخه سیوتی می رز رگرسیوو  تک  2SLSری )روش حدرقل مربعات دو مرحله

مناسییب زمانی رسییت که برخی رز م غورهای سییمت    رسییت. رین روش  2SLSری  معادعه

ناهمتیییانی  و   پواپیهو  هم تییی ای  معادعه با ع اررت خطا مرت ن هتییی ند رما ررسیییت

( رر با 2SLSری )مرحلیه ریویوز حدرقل مربعیات دو  .وجود ندررد در جملات رخلال  ورریانس

ده بر روی معادلات برآورد های وضیع شی بدو  وز ، و محدودیت TSLS رسی فاده رز معادعه

 ری وجود نیدرشییی یه بیاشییید، ن یایا حیدرقیل مربعیات دوکنید. رگر هو  محیدودییت معیادعیهمی

ری بدو  خورهد بود. . روش تک معادعه 2sls( معادل با   2SLSری سیییوتییی می )مرحله

های رز پوش  هایی رسیییت که رز تمام م غوررز روش (2SLS)ری  حدرقل مربعات دو مرحله

 
1 Zellner 
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های کارر و سییازگار رسیی فاده  ه به عنور  م غور ربزرری برری رسییود  به برآوردتعوون شیید

کند. رین روش رگرپه به وی ه برری معادلات بوش رز حد مرخ  به وجود آمده رست، می

 تور  برری حل معادلات دقوقاً مرخ  نوز به کار برد.رما آ  رر می

 (ARCH) واریانس ناهمسانی شرطی اتورگرسیو

( نتیخه پند  ARCH) ورریانس ناهمتیانی شیرطی رتورگرسیوو  ننده سیوتی میبرآورد ک

روشیی مناسیب برری زمانی که فرد   ARCH رسیت. سیوتی   ARCH م غوره برآوردکننده

خورهید میدل وررییانس و کووررییانس جملات خطیا رر، بیه طور کلی در فرم رتورگرسیییوو می

 وررد کند مناسب رست.

 افزارکار با نرم

سیوتی   ریجاد کنود و   Objectبرری برآورد پاررم رهای سیوتی   معادلات، رب در باید یک  

صیورت سیوتی   معادلات رر مریخ  کنود. سیه رره برری ریجاد یک سیوتی   وجود دررد: به

دسی ی و با وررد کرد  یک تصیریح با قررر درد  یک فایل م نی حاوی تصیریح، یا با رجازه 

یک سیوتی   به صیورت خودکار رز طریق عوتیت رن خاب شیده   برری ریجاد ریویوز درد  به

 .کندم غورها ریجاد می

رب در    برری ریجاد یک سییوتیی   جدید به صییورت دسیی ی یا با قررر درد  یک فایل م نی

رر   Enterرر در بخش فرما  ریویوز تای  و    "System"متیور زیر رر طی کنود یا ع ارت  

 کلوک کنود:

Object  > New Object > System 
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شیود. در رین بخش باید مریخصیات سیوتی    با طی متیور بالا پنجره خاعی سیوتی   باز می

برری برآورد پاررم رهای سیوتی   معادلات  ها تکمول کنود.  رر رر با پرکرد  مناسیب گزینه

   .سوت   ریجاد کنود و سوت   معادلات رر مرخ  کنود  Objectشما رب در باید یک  

 

ند رز عوتییت م غورهای رن خاب شییده، به صییورت خودکار معادلات  تورهمچنون می ریویوز

برری رسی فاده رز رین روش رب در م غورهای وربتی ه رر  خطی رر در یک سیوتی   توعود کند.

 .که در سوت   وجود دررد رر برجت ه )هایلاید( کنود

 < Openدر مرحلیه بعید بر روی م غورهیای هیایلایید شیییده دوبیار کلویک کنوید و متیییور  

Open System   رر طی کنود و یا کلوک ررسیت کنود و گزینهOpen > as System  رر

با رسی  م غورهای وررد شیده در   Make Systemرن خاب کنود. در رین حاعت باید پنجره  
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تورنود رگرسیوو  رر رر با رضیافه کرد   یباز شیود. شیما م  Dependent variablesبخش 

 ، یا تخمون زده شده و یا ضرریب خا  معادعه گت رش دهود.ARجملات  

 Equationبخش 

معادلات در سییوتیی     معادلات خود رر با رسیی فاده رز ع اررت رسیی اندررد ریویوز وررد کنود.

 .ضمنی باشدشما باید معادلات رف اری با ضرریب ناشناخ ه و یک جمله خطای  

 

تورنود ضیرریب پوش  ری سیاده رر در نرر باورید. شیما مییک سیوتی   دو معادعه  تصیریح

تورنود رز ضرریب بردررهای رس فاده کنود. رع  ه شما می رر … , C(1), C(2)  ریویوز   فرض

 دیار با کلوک کرد  بر روی متور:

Object > New Object > Matrix-Vector-Coef  > Coefficient Vector 

 در منوی رصلی ریویوز رس فاده نمائود.  

 ترین قورنون عمومی برری تعریف معادلات وجود دررد که شامل: برخی رز مه 
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تورننید نتییی یت بیه م غورهیا، ضیییررییب ییا هردو زورخطی بیاشییینید.  معیادلات می •

  های رعمال شیده در معادلات ممکن رسیت با رسی فاده رز ضیرریب مریابه محدودیت

 در معادلات مخ لف رعمال شود. به عنور  مثال:

y = c(1) + c(2)*x 

z = c(3) + c(2)*z + (1-c(2))*x 

 

ری رر رعمال کنود. معادعه زیر رر های رضافهشما همچنون ممکن رست محدودیت •

 در نرر باورید:

y = c(1)*x1 + c(2)*x2 + c(3)*x3 

 

باشیود.    C(1)+C(2)+C(3)=1شیما ممکن رسیت مایل به تحمول محدودی ی به صیورت  

 دهد:رر به صورت زیر تغوور می  تورنود رین محدودیت معادعهشما می

y = c(1)*x1 + c(2)*x2 + (1-c(1)-c(2))*x3 

 

( باشیید رما ARمعادلات ممکن رسییت شییامل مرییخصییه خطای رتورگرسییوو ) •

ن اشید. در رین مورد شیما باید ضیرریب رر به   SMAو  MA  ،SARهای مریخصیه

رر در یک پررن ز قررر دهودو برری   ARری  ررت اب دهود. مریخصیه  ARهر جمله  

 ( رس فاده کنود:”=“به ضرریب همانند زیر رز علائ  متاوی )  ARمرت ن کرد   

cs = c(1) + c(2)*gdp + [ar(1)=c(3), ar(2)=c(4)] 
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مریابه رر با  AR یبردر یک سیوتی   محدود کنود تا ضیرتورنود تمام معادلات رر  شیما می

  همچنون  درده شییود. ARمرییابه نوز به رندرزه هما  مقدرر ضییریب    درد  تمام معادلات

 .رر با تعوون هر معادعه ضریب خود محدود کنود AR های جدرگانهتورنود پردرزشمی

متاوی    معادلات در یک سوت   نوازی به یک م غور وربت ه ندررند که علامت •

 تورند در هر جای فرمول باشد:می "="علامت  )=( رر دن ال کند.

log(unemp/(1-unemp)) = c(1) + c(2)*dmr 

 

تورنود معادعه رر با یک بوا  سییاده و بدو  نواز به م غور وربتیی ه مانند  شییما همچنون می

 مثال زیر بنویتود:

(c(1)*x + c(2)*y + 4)^2 

 

تمام ع ارت رر  ع ارت که یک علامت متیاوی )=( ندررد، ریویوزهناام مورجه شید  با یک  

 .دهدقررر می  1برربر با جملات خطای ضمنی

 ابزارها

کنود، باید م غورهای ربزرری رسیی فاده می GMMو یا    2SLS ،3SLSرگر شییما رز روش  

های مخ لفی برری مریخ  کرد  ربزررهای موردنواز  مورد رسی فاده رر تعوون کنود. روش

 
1 Implicit Error Term 



  ایویوز افزارنرم   اقتصادسنجی کاربردی پیشرفته با

 

84 

 

خورهود ربزررهای یکتا  در هر معادعه  که آیا مید دررد که با فرم مناسب بت ه به رینوجو

 ها رر بر رسا  معادعه محاس ه کنود.بونیخورهود پوشکه آیا میدرش ه باشود و یا رین

های م غور ربزرری خود رر بونیترین مورد ممکن )حاعت پوش فرض(، ریویوز پوشدر سیاده

دهود به رین فرریند به عنور  دهند. رگر ترجوح میه معادعه تریکول میبر رسیا  معادعه ب

نااه کنود، رگرسیوو  رول م غورها در مدل شیما بر روی  (2SLS) رییک روش دو مرحله

   .شودربزررها به طور جدرگانه برری هر معادعه رجرر می

مایل به رس فاده   در رین تنرومات دو روز برری برری مرخ  کرد  ربزررها وجود دررد. رگر

رز م غورهای ربزرری یکتییا  در معادلات هتیی ود، باید یک خن معادعه با کلمات کلودی  

@INST    و یاINST    و عوتی ی رز م غورهای متی قل در ردرمه آ  که قررر رسیت به عنور

 ربزرر رس فاده شوند، رر وررد کنود. برری مثال خن:

@inst gdp(-1 to -4) x gov 

رر برری رس فاده رز شش م غور به عنور  ربزرر برری تمام معادلات در سوت      ریویوزدس ور  

  معادلات   کند. برآورد سوت   شامل یک طرز مجزر برری هر معادعه در سوت  هدریت می

 شما خورهد بود.

شییما همچنون ممکن رسییت ربزررهای مخ لفی برری هر معادعه رر با رضییافه کرد  علامت 

معادعه مرییخ  کنود و سییپس یک عوتییت رز ربزرر برری رین معادعه رر در رن های   "@"

 به عنور  مثال:  .مرخ  کنود

cs = c(1)+c(2)*gdp+c(3)*cs(-1) @ cs(-1) inv(-1) gov 

inv = c(4)+c(5)*gdp+c(6)*gov @ gdp(-1) gov 
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ر  بیه عنور  م غوو ییک جز  ثیابیت )عرض رز م یدر (    cs(-1), inv(-1) govمعیادعیه رول رز  

و یک جز  ثابت رر به عنور  gov  و    gdp(-1)  در معادعه دوم. اما کندربزرری رسی فاده می

 گورد.م غور ربزرری در نرر می

تورنود رین دو روش رر ترکوب کنود. هر معادعه بدو  ربزررهای مریخصیه  در نهایت شیما می

به عنور    شیود.رر مریخ  می  "inst@"رنفرردی رز ربزررهای مریخ  شیده توسین ع ارت  

 مثال در سوت   زیر: 

 

@inst gdp(-1 to -4) x gov 

cs = c(1)+c(2)*gdp+c(3)*cs(-1)  

inv = c(4)+c(5)*gdp+c(6)*gov @ gdp(-1) gov 

 

و   ,GDP(-1), GDP(-2), GDP(-3), GDP(-4), X, GOVرز م غورهای    CSمعادعه  

 کند.  م غور ربزرری رس فاده میبه عنور   gov  و    gdp(-1)رز   INVجز ثابت و در معادعه  

 چند نکته

های مورد رسی فاده، در صیورتی که تعدرد م غورهای ربزرری رز تعدرد  در زمونه روش •

ترین روش قابل ق ول  2SLSشیود که روش  مریاهدرت بوری ر رسیت، پورینهاد می

 برآورد رست.
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برری طرز • ربزررهیا  کرد   معون  پرویهبرری  ع یارت  بنیدی  رز   stackinst@هیا، 

در دسی ر     3SLSو    2SLSشیود. رع  ه رین ع ارت تنها برری روش  رسی فاده می

 در دس ر  نوتت.  GMMرست و برری روش 

جز  م غورهای ربزرری باشید، رین شیامل معادلات رنفرردی  Cدر صیورتی که ع ارت   •

در بون م غورهای ربزرری ن اشیید در آ  صییورت به   Cشییود. در صییورتی که  نمی

شییوده رگرپه به صییررحت رین موضییوی  هر معادعه گنجانده می  عنور  یک ربزرر در

 بوا  شده باشد.

درده    رر به عنور  ربزرر برری معادعهسیمت ررسیت  متی قل  شیما باید تمام م غورهای   •

 شده فهرست کنود.

متیی لزم آ  رسییت که در هر معادعه باید حدرقل تعدرد زیادی رز ربزرر   1شییناسییایی •

)شیامل جز  ثابت( وجود درشی ه باشید، زیرر م غورهای سیمت ررسیت )م غورهای  

 2مت قل( در آ  معادعه وجود دررد.

در دسییی ر  رسیییت و برری    3SLSو    2SLSتنهیا برری  @ stackinstبویا    •

GMM  .در دس ر  نوتت 

کنود  رر با رسیی فاده رز یک روش که رز ربزرر رسیی فاده نمی  رگر شییما سییوتیی   خود •

 .شوندبرآورد کنود، تمامی خطوب مرخصه ربزرر نادیده گرف ه می

 حال با توضوحات بالا شووه برآورد یک سوت   توضوح درده خورهد شد.

 
1 Identification 

در سیرتاسیر رین ک اب منرور رز م غورهای سیمت ررسیت، م غورهای متی قل و منرور رز م غورهای سیمت پ  نوز   2

 م غورهای وربت ه رست.
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 افزار ایویوزبرآورد یک سیستم با نرم

رر روی نورر   Estimate ورنود دکمهتزمانی که سوت   خود رر ریجاد و مرخ  کردید، می

 باز شود. Discovery Estimation ربزرر فرار دهود تا پنجره

 

بیه شیییمیا پنید گزینیه برری روش برآورد رررئیه    Estimation Methodری  منوی کرکره

تورنود رز یکی رز پند روش برری برآورد پاررم رهای مریخ  شیده خود دهد. شیما میمی

 .رن خاب کنود

های دیاری رر رررئه دهد. رآورد ممکن رسیت نتی ت به رن خاب شیما تغوور و گزینهپنجره ب

کند، کادری ظاهر خورهد شید رگر برآوردگر رن خاب شیده رز م غورهای ربزرری رسی فاده می

 و یا وقفه رگرسورها رر وررد کنود.  ARکه شما رر باید برری رفع  رن خاب کنود باید فرریند  



  ایویوز افزارنرم   اقتصادسنجی کاربردی پیشرفته با

 

88 

 

 GMMتنظیمات 

ری بوریی ری به شییما  رر رن خاب نمائود، گزینه  GMM-Cross Sectionرگر شییما گزینه  

دررین حاعت رز یک رگرسیوو  مقاوم    GMMشیود. توجه درشی ه باشیود که روش رررئه می

شییده نتیی ت به ناهمتییانی ورریانس و هم تیی ای پواپی که شییکل آ  ناشییناخ ه رسییت 

رین رگرسیوو    GMM-Time Series (HAC)کند. در حاعی که در روش  رسی فاده می

 دهد.مقاوم شده رر به فرم ناشناخ ه خودهم ت ای گت رش می

 Identity Weighting Matrixرر رن خاب کنود ریویوز گزینه    GMMرگر شییما روش 

in Estimation  های  دهد. ضرریب برآوردی و مرخصهرر نرا  میGMM   برری محاس ه

یک ماتریس کوورریانس که مقاطع نتی ت به ناهمتیانی ورریانس و خودهم تی ای مقاوم  

ه  در برآورد و  GMMهای  شیده رسیت. رگر رین گزینه رن خاب نریده باشید ریویوز رز وز 

 ه  در محاس ه کوورریانس ضرریب رس فاده خورهد کرد.
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گزینیه   رن   GMM-Time Series (HAC)وق ی شیییمیا  ریویوز رر  پنجره  خیاب کنوید، 

های جدید در سیمت گزینه  .دهدهای رضیافی برری تعوون وز  ماتریس رر نریا  میگزینه

ها ناهمتیانی ورریانس و خودهم تی ای مقاوم شیده شیود. رین گزینهررسیت پجره ظاهر می

 کند.ماتریس وزنی رر کن رل می

برری    رتوکووررییانسدهی  مورد رسییی فیاده برری وز   Kernelفرم ت یابعی    Kernelگزینیه  

تعوون کننیده    Bandwidth Selectionدهد. گزینیه  محیاسییی یه ماتریس وزنی رر رررئه می

با وقفه رتوکوورریانس در محاسیی ه روزر    Kernelپاونای وز  درده شییده توسیین تغوور  

وید تعیدرد تورنرر رن خیاب نمیائوید، شیییمیا می  Fixedمیاتریس رسیییت. رگر دز رین بخش  

Bandwidth و یا ع ارت"NW" رر برری رسی فاده رز Newey   و  West’s  رن خاب   معوار  

Bandwidth   .رر تعوون کنود 

 ARCHبخش  

رن خاب شود، پنجره موردنرر   ARCH - Conditional Heteroskedasticityرگر روش  

 شود.ظاهر  می  ARCHهای  برری مدل
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 Model Type  دهد تا رز بون سیه مدلبه شیما رجازه می ARCH  پند م غوره مخ لف

Diagonal VECH, Constant Conditional Correlation (CCC)  وDiagonal 

BEKK    .یک گزینه رر رن خاب نمائود 

دهد.  تعدرد جملات خودرگرسیییوو مدل رر نریییا  می  Auto-regressive orderگزینه  

برری تعوون رگرسیییورهیای    Variance Regressorsهمچنون ممکن رسیییت رز گزینیه  

موجود در معادعه ورریانس رسی فاده کنود. مریخصیات ضیرریب برری جملات خودرگرسیوو و 

 ARCH Coefficientرگرسیورها در معادعه ورریانس ممکن رسیت با رسی فاده رز گزینه  

Restrictions  .کن رل شود 

شیما باید یک    .شیودایش درده میهر جمله خودرگرسیوو یا رگرسیورها در عوتیت ضیرریب نم

یک مرییخصییه نوی     Restrictionجمله رر برری رصییلاز آ  رن خاب کنود و در قتییمت  

، هر یک رز ماتریس ضرریب  VECH برری مدل  .ضریب رر برری رصطلاز آ  رن خاب کنود

 Scalar, Diagonal, Rank One, Full Rank, Indefinite Matrixممکن رسیت به 
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فرض توزیع جملات رخلال نرمیال   محیدود شیییود. بیه طور پوش  Variance Targetو ییا  

 Multivariate Student'sری بیه جیای  شیییود. شیییمیا بیایید آ  رر در نورر کرکرهفرض می

 رن خاب کنود.   Error Distributionگزینه  

 FIMLبخش  

شییود  ، رز شییما خورسیی ه میFIMLهای برآورد شییده با رسیی فاده رز روش برری سییوتیی  

   .های ماتریس کوورریانس رر مرخ  کنودماندهتنرومات برآورد برری باقی

 

می  Residual Covarianceبخش   رجییازه  بون  بییه شیییمییا  رز   ,Unrestrictedدهیید 

Diagonal, User-covariance   وUser-factor    .یکی رر رن خاب کنود 
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 رزبرآوردگیییرررزییییابی رسییی اندرردی  Unrestricted Settingبخیییش  •

FIML هییای مییاتریس کوورریییانس مانییدهرست کییه در آ  تمییام عناصییر بییاقی

 .شودهمرره با ضرریب معادعه مواناون محاس ه می

  Diagonalتنرومات   •

  FIMLهای سیوتی   برآورد شیده با رسی فاده رز برآوردگر Objectتوجه درشی ه باشیود که  

های ریویوز ( با نتییخهUser-Factor   و  Diagonal, User-Specifiedمحدود شییده )

 ( قابل رنجام نوت ند.10های ق ل رز نتخه ق ل )نتخه

 هاسایر گزینه

  هیای و سیییوتییی    3SLS  ،GMMوزنی،    SUR  ،TSLS  ،برری حیدرقیل مربعیات وزنی

برری کن رل روش برری محاسی ه ماتریس   بوری ری های رضیافی، گزینهزورخطی  معادلات

GLS برری سیوتی      دررد. همچنون وجود  یبرو بردرر ضیر  یوزنARCHیب در  ر، بردرر ضیر

به عنور  به خوبی به عنور  پوش فرض و گزینه های خطای    شیییود.رسییی فاده می برآورد

 رس اندررد.
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در پنجره برآورد، روش تکررر ضرریب، ماتریس وزنی و یا هر دو رر مرخ     Optionبخش  

روی  می بر  گزینیه  رین  فرض  پوش  حیاعیت  —Update weights once, thenکنید. 

Iterate coefs to convergence  .قررر دررد 

رر با رسی فاده رز ماتریس   (First-Stageدر حاعت پوش فرض ریویوز تخمون مرحله رول  )

در صیورتی   TSLS)یا   OLSدهد. با رسی فاده رز مقادیر روعوه حاصیل رز  ی رنجام میزور وزن

که ربزرر وجود دررد(، ریویوز تخمون مرحله رول رر تا زمانی که ضیرریب همارر شیوند ردرمه 

 رین روش شیامل یک رگرسیوو  تک معادعهدهد. در صیورتی که تصیریح خطی باشید،  می

OLS یا TSLS تخمون مرحله رول برری ریجاد یک برآورد سیازگار    هایماندهباقی .رسیت

   .شودبا ماتریس وزنی رس فاده می
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دهی شیییده در ریجیاد برآورد ضیییرریب  های وز ریویوز رز ماتریس  1در تخمون مرحلیه دوم

کند. رگر تصیریح زور خطی باشید، برآورد تا همارر شید  ضیرریب تکررر جدید رسی فاده می

 خورهد شد.

برآوردهیای   then—Update coefs once و    Update weights onceهیای  گزینیه

ضییرریب رر  کند. ریویوز هماررییدهد و ماتریس وزنی رر برآورد میمرحله رول رر رنجام می

   .دهدری رر رنجام میکند، بلکه یک مرحله تکررر ضرریب تک مرحلهتکررر نمی

  ح وبه طور صیح یرمرحله  ک ی  تیآپد نیهتی ند، ر  مرحله رول سیازگار بیجا که ضیرررز آ 

  د و، توعباشدرر که مرابه روش رول   یجین ا باشد،  یخط حیتصر کهنیگر ررسازگاررست، رما 

 کند.ینم

دهند که کارریی  توجه درشی ه باشیود که تمام پهار روش برآورد، ن ایجی رر به دسیت می

معیادل    Iterate Weights and Coefs، دو گزینیه  هیای خطیبیالایی دررنید. برری میدل

 یبرمعادل هتیی ند، زیرر ضییر One-Step Weighting Matrixهتیی ند و دو گزینه  

  نوازی به تکررر ندررد.شده   برآورد

 
1 Second Stage 
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 شود:می های زیر رررئهشود مجموعه گزینهرن خاب می ARCHزمانی روش  

که په مقدرر شیروی برری شیروی    دهدنریا  می  Starting Coefficient Valueگزینه  

رین مورد بر روی گزینیه   فررینید تکررر در ریویوز موردنویاز رسییییت. بیه طور پوش فرض 

EViews Supplied تورنود گزینه  وجود دررد. شیییمیا همچنون میUser Supplied  رر

های  ر گزینهیا سای (Cدهد تا ضریب شروی خود رر رز جز  ثابت )برری که به شما رجازه می

 در دس ر  رن خاب کنود.

نام ضییرریب مورد رسیی فاده در معادعه ورریانس رر  Coefficient nameگزینه   •

 تورند م فاوت رز مواناون معادعه باشد.  که می  کندمرخ  می

دهنده روشیی رسیت که  نریا   Starting (Presample) Covarianceگزینه   •

 .مورد رن رار محاس ه شودباید ورریانس شرطی نمونه و نوآوری 
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 مروری بر یک مثال تجربی 

 (1997مثال تجربی گرین )

های رز با رسیی فاده رز دردهشییود که  در ردرمه برری نکمول بحث یک مثال تجربی رررئه می

( رررئه شییده رسییت و به صییورت زیر  1997)  2گرین  که توسیین( به 1975)  1وودبرندت و 

 3رست:

 

رسیییت. همچنون   iبیه ترتویب هزینیه و قومیت فیاک ور    iPو      iC  در رین معیادعیه بیه ترتویب

β و δ   نوز پارم رهایی هتیی ند که باید برآورد شییود. توجه درشیی ه باشییود که محدودیت

  .ضریب معادعه م قابل وجود دررد که م ضمن تقار  مر قات جزئی م قابل رست

 مرحله اول 

 در مرحله رب در پنجره سوت   رر مطابق معادلات بالا به صورت زیر تکمول کنود:

 
1 Berndt and Wood 
2 Greene 

 موجود رست.  ”G_cost.WF1“های مورد رس فاده در رین مثال در سایت ریویوز و تحت عنور  درده 3
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شیییود. ن ایا برآورد به برآورد می  (FIML)1رح مال رطلاعات کاملمدل رب در با حدرکثر  

 صورت زیر خورهد بود: 

 

 

 
1 Full Information Maximum Likelihood 



  ایویوز افزارنرم   اقتصادسنجی کاربردی پیشرفته با

 

98 

 

 ها متور زیر باید طی شود: برری آزمو  محدودیت

View > Coefficient Diagnostics > Wald Coefficient Test 

 رر کلوک کنود:   OKفولد زیر رر تکمول کنود و گزینه 

 

 یر خورهد بود:ن ایا برآورد به صورت ز
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(، بنابررین فرضییوه  93/0رسییت )  05/0با توجه به رح مال برآورد شییده که بوریی ر رز رز 

 تور  رد کرد.محدودیت تقار  مورد آزمو  رر نمی

 برری برآورد محدودیت م قار  رعمال شده بر سوت   معادلات، متور زیر رر طی کنود:  

Object > Copy Object 

 و سپس  

View > System Specification 

 سپس پنجره سوت   رر مطابق زیر )یا هر نوی محدودیت دیاری( تغوور دهود:

 

 گذرری شده رست. نام  SYS_TLOGدر رین مورد خا  سوت   مورد نرر 

به عنور  .  شودها با رس فاده رز ضرریب مرابه در هر معادعه رعمال میمحدودیت: نک ه مه 

 log هما  ضیریب ضیریبC_K(C (3)  ) معادعهدر     log  (P_L / P_M)مثال، ضیریب 

(P_K / P_M) در معادعه C_L رست. 
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 Fullکلوک کنود و گزینه   Estimateبر روی گزینه    FIMLبرری برآورد معادعه با روش 

Information Maximum Likelihood    .برری برآورد معیادعیه رویرر رن خیاب کنوید 

OK کلوک کنود. 

 

در قتیمت رول در بخش پائونی خروجی گزررش شیده رسیت   1مقادیر عااری   درسی نمایی

 آزمو  نت ت درس نمایی ممکن رست مورد رس فاده قررر باورد.که برری 

شییود که توزیع جملات باقومانده نرمال فرض شییده رسییت، ممکن  جا که فرض میرز آ 

باقومانده نرمال رسیت یا خور  بر روی متیور زیر کلوک  رسیت مایل باشیود توزیع جملات  

 کنود:

Proc > Make Residuals 

 
1 Log Likelihood 
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 ها باز شود. تا پنجره باقومانده

 

رر رن خاب نمائود.  Standardized Residuals و یا     Ordinaryشیما ممکن رسیت گزینه  

ذخوره شیود ها که با آ  رسی   در آخرین بخش نوز نام موردنررتا  رر برری سیری باقومانده

رن خاب شیده رسیت. رن خاب رسیامی    RESIDرر وررد نمائود. رسی  رن خاب شیده در رین مورد  

ری باشید که در زما  رسی فاده مریخ  باشید که باقومانده م علق به کدرم برآورد باید باونه

 کند.  ها برری برآوردهای مخ لف، تغوور میرسته زیرر باقومانده

رن خاب شیییده رسیییت.    Ordinary Residualsرکاربرد  در مثال مورد بررسیییی گزینه پ

رب در برو  های مورد رسی فاده  برری محاسی ه آمار توصیوفی برری هر یک رز سیریهمچنون  

 زیر رر طی کنود:  روی م غور مورد نرر دوبار کلوک کنود و سپس متور  

View > Descriptive Stats > Common Sample 

 ن ایا به صورت زیر خورهد بود:
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شیییود.  نم  و .... برری هر م غور محیاسییی یه میدر رین پنجره، مویاناون، مید، میاکزیم ، می

کند.  فرضوه نرمال بود  توزیع رر آزمو  می Jarque-Bera همچنون در خروجی بالا آمار

درصید باشید  5فرضیوه صیفر رین آزمو  نرمال بود  توزیع رسیت. رگر مقدرر رح مال بالای  

،  RESID1شییود. در مثال بالا به ترتوب سییه سییری ف ه میفرضییوه توزیع نرمال پذیر

RESID2    وRESID3  .نرمال، زورنرمال و نرمال هت ند 

برآورد ضیرریب رز تابع هزینه تررنتیلوگ ممکن رسیت برری برآورد کریش جانریونی بون 

بون سیرمایه و   به عنور  مثال، کریش جانریونیعورمل توعود مورد رسی فاده قررر باورد. 

 ع ارت: توسن  1کار

1+c(3)/(C_K*C_L) 

 
1 Capital and Labor 
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 C_K ثابت نوتیت و به مقادیر  جانریونیتوجه درشی ه باشیود که کریش  شیود.  محاسی ه می

 . متور:بت ای دررد C_L و

Quick > Generate Series 

 رن خاب کنود و ع ارت:  

es_kl = 1 + sys_tlog.c(3)/(c_k*c_l) 

رر وررد کنود. برری مراهده کرش جانرونی بون سرمایه و نوروی کار در در هر مراهده،   

 در فایل کاری کلوک کنود و متور زیر رر طی کنود: ES_CLدوبار بر روی سری  

View/Graph/Line & Symbol 
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در حاعی که کریش جانریونی مورد بررسیی در نمونه م غور رسیت، کریش جانریونی به 

 .رست  1درگلا -ک به یک رست که مطابق با فرضوه هزینه تابع کابطور کلی نزدی

 System ARCHمثال تجربی با 

 شود:رررئه می ARCHدر رین بخش یک مثال برری برآورد سوت    

( و پونید tsf(، فررنیک سیییوئوس)tjyهیای بیازدهی هف ای ین یرپن )در رین مثیال رز درده

 2شود.( رس فاده میtbp) رنالوس

 معادلات مورد بررسی به صورت زیر رست:

 

 شود:  سازی میقطری پایه مدل  VECHکوورریانس شرطی با رس فاده رز یک  

 

 :( با مرخصات زیر ریجاد کنودSYS01) برری برآورد رین مدل، یک سوت  

dlog(jy) = c(1) 
dlog(sf) = c(2) 
dlog(bp) = c(3) 

 
1 Cobb-Douglas Cost Function 

 شود. شناخ ه می ”Fx.WF1“های مورد رس فاده در رین مثال در سایت ریویوز و با نام فایل کاری  درده 2
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رز پنجره برآورد   ARCH - Conditional Heteroskedasticityرین میدل رر رز گزینیه  

رسییت، بوریی ر تنرومات رد    Diagonal VECHجا که هدف برآورد رن خاب کنود. رز آ 

تغوور   "1980 2000"، نمونیه رر بیه Sampleشیییود. در بخش  رین حیاعیت قررر درده می

کلوک کنود تا  OK بر روی گزینهقررر باورد.   دهود تا فقن بخریی رز نمونه مورد رسی فاده

   .سوت   تخمون بزنود
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ضیرریب  C (9) تا C (4) ضیرریب .شیودضیرریب ورریانس در همون بخش نمایش درده می

 رز طریق C (16) و ARCH ضیرریب جملات   C (15) تا  C (10)برری ماتریس ثابت، 

C (21)   ضرریب برری جملاتGARCH .رست 

تورند بتیوار بزرگ می ARCH درشی ه باشیود که تعدرد ضیرریب ورریانس در یک مدلتوجه 

شیود، و تفتیور  پاررم ر تخمون زده می 18م غوره،   3ح ی در رین سیوتی   کوپک   باشید.

یک بخش  آ  تا حدودی دشورر رست. برری کمک در تفتور ن ایا، ریویوز برری رین حاعت،

کند که برپتب های مجدد و ی برآورد رررئه میمریخصات کوورریانس رر در رن های خروج

 :دهدضرریب رر تغوور می
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کند، در رین خن رول رین بخش، مدل کوورریانس مورد رسی فاده در برآورد رر مریخ  می

قررر دررد. خن بعدی توضییوح مدل رسییت که ما   VECH Diagonalموردبر روی گزینه  

ماتریس ورریانس   GARCHرین مورد، در   .در فرم م ن رخ صیار برآورد رررئه شیده رسیت

 ماتریس ضییریب برری ع ارت A1ضییریب ثابت ماتریس رسییت،   "M"شییرطی رسییت،  

ARCH رست و B1 ماتریس ضریب برری مدت GARCH رست  . M ،A1و ، B1  به نوز

   .رستعنور  ماتریس نامحدود تعریف شده 

جا که  رز آ  شییود.سییپس، مقادیر برآورد عناصییر ماتریس و سییایر آمارها نمایش درده می

های ورریانس نامحدود هتی ند، مقادیر یکتیا  هتی ند و با ضیرریب ورریانس خام  ماتریس

، با ضیریب M ( در ماتریس  1،1، عنصیر )M (1،1)گزررش شیده رسیت. به عنور  مثال،  

و ... رسییت.     C (10)به    A1 (1،1)، و C (5)مربوب به            C (4)  ،M (1،2)خام  

یا رت ه کامل هتیی ند، مقادیر گزررش شییده در رین  1برری ضییرریب ماتریتییی که رت ه  

 بخش، ت دیل به ضریب برآوردی خام شده رست. 

 

تور  با کلوک بر  کووریانس رر می-ری مربوب به معادعه ورریانسیک رگرسیوو  تک معادعه

 روی متور: 
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View  > Representations 

 رر کلوک نمائود.  Variance and Covariance Equationsگزینه   و

 COV معادلات ورریانس شیییرطی هتییی نده در حاعی که معادلات ،GARCHمعادلات

ورریانس شییرطی ین یرپن   GARCH1 برری مثال معادلات کوورریانس شییرطی هتیی ند.

  .کوورریانس شرطی بون ین یرپن و فررنک سوئوس رست COV1_2 رست و  

و پذیرش   Name ( رر با کلوک بر روی دکمهSYS01ردرمه ردرمه درد ، سیوتی   )ق ل رز  

 کنو .گذرری میفرض یا رن خاب رس  جدید نامنام پوش

 / View تورند با رسییی فاده رز کوورریانس و با متیییور  یک نمودرر ورریانس شیییرطی می

Conditional یانس، هم ت ای،  ، رز جمله کووررهاری رز گزینهعوتت گت رده  .ریجاد شود

رررئه هم تی ای    بخشجا در رین .ها در دسی ر  رسیتدرده رنحررف، و رنحررف رسی اندررد

 شده رست: 
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 .رسد هم ت ای در طی زما  م غور رست، که یک وی گی کلی رین مدل رستبه نرر می

، که با گذر  CCCرمکا  دیار رین رسیت که ماتریس کوورریانس رر با رسی فاده رز مریخصیه 

سیازی کرد.ر با ریجاد یک سیوتی   جدید با مریخصیات  ا  هم تی ای ثابت دررد، مدلزم

 Constant  دهو . در ردرمیه گزینیه  پیه کیه در بیالا آمیده رسیییت ردرمیه میمریییابیه آ 

Conditional Correlation  و برری زمیا  گزینیهModel Type    و سیییایر تنرومیات

 طور که هت ند قررر دهود. ن ایا رساسی به صورت زیر رست: ها رر هما ماندهباقی

 

پاررم ر آزرد در معادعه ورریانس دررد، در   12توجه درشیی ه باشییود که رین مرییخصییه فقن  

بخش ورریانس توسیییعه نریییا  دهنده معادعه   .پاررم ر که در مدل ق لی 18مقایتیییه با  

 ورریانس رست:
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GARCH(i) = M(i) + A1(i)*RESID(i)(-1)^2 + B1(i)*GARCH(i)(-1) 

 

 به صورت زیر رست: در حاعی که مدل معادعه کوورریانس  

COV(i,j) = R(i,j)*@SQRT(GARCH(i)*GARCH(j)) 

 

به  R(2, 3)و     R(1, 2)، (1  ,3)R دهد که هم تی ای  تر خروجی نریا  میبخش پایون

 رست: -6773/0و   -4032/0، 5713/0 ترتوب برربر با 

 

 سورل مه  

آیا رین مدل به ر رز مدل ق لی رسیییت  در حاعی که عااری   درسییی نمایی کم ر رسیییت، 

تورنو  با نااه کرد  به معوارهای رن خاب مدل، دو سیوتی   رر تر نوز دررد.  میضیرریب ک 

دهند که هر سیه کوئون نریا  میهای آکائوک، شیوررز و هنا مقایتیه کنو . مقادیر آماره
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تر رسیت. رین موررد ک   CCCنتی ت به مدل    VECHرری مدل  معوار رطلاعاتی ب  شیاخ 

 به ر بوده رست.  VECHتغوور زما     کند که مدلپورنهاد می
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 مقدمه

(، به دن ال پاسیم به رین 1999)  2رررئه شیده توسین هانتین  1ریروش رگرسیوو  آسی انه

کند یا  ی مریاهدرت ع ور میسیورل رسیت که آیا توربع رگرسیوونی به طور یکنورخت رز همه

خطی معمولاً  ی روربن زورتجزیه و تحلول سینّ های مجزر شیکتی ه شیوند تورند به گروهمی

ی دروری و زر رسیت که بر پایهبر رسیا  رهوافت تقتیو  نمونه به دو گروه به صیورت برو 

ها و  ترجوحات فردی رسی ورر رسیت. در صیورت رسی فاده رز رین روش، رن خاب تعدرد ریی

در رین صورت، صحت    رورز رینرق صیادی ق لی رسیت.  تئوری  محل آ  رخ واری و بر رسیا 

بررناوز رسیت، زیرر به طور وسیوعی به رن خاب   پاشن ایا و پاررم رهای تخمون زده شیده  

 دهد، وربت ه رست.نه در آنجا رغ میری که آس انقطه

گورد، روش ری مورد رسییی فاده قررر میروش دیاری که در تجزیه و تحلول های آسییی انه

ها رر به طور کاملاً  پی یا درخت رگرسیوونی رسیت که شیمار و محل آسی انهدررگرسیوونی پی

(. 32005،ی و ونگ کند )عهای موجود تعوون میسازی دردهتبگوری رز مرّزر و با بهرهدرو 

ی یک تکنوک  ( با رررئه2000و    1999، 1997)  4به طور جدی توسیین هانتیین  بحثرین 

جدید در رق صیادسینجی توسیعه درده شیده رسیت. رز مزریای دیار رین روش رین رسیت که  

گونه فرم  ی دخاع ی ندرشی ه و نواز به هو خطّگوری نوی رربطه زورررت ذهنی در شیکلتصیوّ

 .ی ندرردی در بررسی روربن زورخطّخطّرتابعی معون زو

 
1 Threshold Regression 
2 Hansen 
3 Lee and Wong 
4 Hansen 
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باشییند که  { i<n , 1≤t<T it, x it, q ity≥1:های ترکو ی م عادل به صییورت  رگر درده

ر  و م غوّ ityر وربتی ه  گر زما  رسیت. م غوّنمایا  tنریا  دهنده مقاطع و رندیس   iرندیس  

یک بردرر رست. فرم ساخ اری رین  itxرسکاعر هت ند در صورتی که رگرسور  itqری آس انه

 :رستمدل به صورت زیر  

 Yit  = μi +  β1
′ xit I(qit ≤ γ) +  β2

′ xitI(qit > 𝛾) +  eit 

 .رست تابع شاخ   I(0)که در آ  

، به دو  رسیتری  آسی انه  γتر یا بوری ر رز  ک qit ر آسی انه مریاهدرت بر رسیا  رینکه م غوّ

مریخ    β2و   β1های رگرسیوو   ها توسین تفاوت شیوبشیوند. رین ریی تقتیو  میریی   

ناپذیر  در طول زما  تغوور xitمتی لزم آ  رسیت که عناصیر    β2و   β1شیوند. شیناسیایی  می

نوز در طول زما  تغوور ناپذیر  qit ری  ر آس انهن اشیند. همچنون فرض شیده رست که م غوّ

رض شیده رسیت که زوروربتی ه و به طور یکتیا   ، ف eitی خطای  نوتیت. در مورد جمله

  رست.  2σتوزیع شده رست و دررری مواناون صفر و ورریانس محدود  

 افزارکار با نرم

در منوی رصییلی    رفزرر ریویوز  یکی رز دو متییور زیر رربرری شییروی فرریند تخمون در نرم

 ریویوز طی کنود:

Object > New Object > Equation  
 یا

 Quick >  Estimate Equation 
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ری در بخش رر در نورر کرکره  Threshold - Threshold Regressionسیییپس گزینه  

Method تورنود در بخش فرما   رن خاب کنود. همچنون به عنور  یک روش جایازین می

رر کلویک کنوید تیا پنجره زیر بیاز   Enterرر تیایی  کنوید و کلوید    Thresholdریویوز ع یارت  

 شود:

 

 وجود دررد.Options و  Specification رصلی شامل    Tabدر پنجره باز شده دو  

 Specificationبخش  

جا سیه بخش مجزر در صیفحه مریخصیات رگرسیوو  آسی انه وجود دررد: مریخصیات  در رین

  Equation specification. در بخش معادعه، مرییخصییات آسیی انه و مرییخصییات نمونه
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یک عوتیت رز ضیرریب خا  آسی انه رر وررد کنود. م غورهای  م غور وربتی ه رر وررد کنود و 

 های آس انه رریا رست.توضوحی ممکن رست شامل وقفه م غورها باشد که در مدل

شییما باید مرییخصییات یک یا پند    Threshold Variable Specificationدر بخش 

عدد  یا پند  تورنود رین خصیوصیوات رر به عنور  یک  شیما می وررد کنود.م غور آسی انه رر  

 :صحوح یا یک عوتت رز م غورها رر رررئه دهود

مقدرر رر به عنور  پاررم ر   رگر شیییما یک عدد صیییحوح رر وررد کنود، ریویوزرین  •

کند. بنابررین، رگر م غور وربتیی ه ی تفتییور می  SETAR وقفه در یک مدل

رر  3  عدد  Threshold variable specification باشید و شیما در Y شیما

و به عنور  م غور آسیی انه رسیی فاده   Y(-3) می شییوید، ریویوز رین عدد رروررد  

 .کندمی

رز رین م غور به عنور  م غور آسی انه  ریویوزنام یک م غور رر وررد کنود،    شیما  رگر •

رر به   W  ریویوزرر وررد کنود،   "W" بنابررین، رگر شییما  .رسیی فاده خورهد کرد

 کند.عنور  م غور آس انه برآورد می

رگر شیییمیا ییک ییا پنید م غور وقفیه رر وررد کنوید، ریویوز رز تخمون میدل برری   •

کند. به ع ارتی رگر شییما در  های وررد شییده عمل میبه رین وقفه در موا  وقفه

رر وررد   "9،  7،  4،  1  "رعیدرد  Threshold Variable Specificationبخش  

بون هر جفیت عیدد رر   ریویوز رعیدرد  رر برآورد کنوید  SETARهیای  کنوید و میدل

گورد )یعنی م غورهیای آسییی یانیه در رین حیاعیت  نوز بیه عنور  م غور در نرر می

رسییت و   {Y(-1), Y(-2), Y(-3), Y(-4), Y(-7), Y(-8), Y(-9)}شییامل  

 کند.ها تعوون میم غور آس انه بهونه رر با رس فاده رز مجموی مربع باقومانده
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وررد کنود ریویوز ا رررئه عوتیی ی رز نام ها  رگر شییما بوش رز یک م غور رر تعوون ب •

کنید و ریویوز رز هر ک غور بیه عنور  م غور آسییی یانیه برآورد می  TRهیای  میدل

 شود.ها تعوون میرن خاب مدل با رس فاده رز حدرقل مجموی مربع باقومانده

همچنون   .رسییت  (SSR)1هامناسییب، مجموی مربعات باقومانده معوار رن خاب مدل

 ه باشیود که مریخصیات آسی انه شیما ممکن رسیت مریخصیات عدد صیحوح و توجه درشی 

 .عوتت م غور صریح رر ترکوب نکند

 Optionبخش  

شیامل تنرومات رضیافی برری محاسی ه ماتریس کوورریانس ضیریب،  Optionصیفحه  

رررئه های آس انه  شرز مخ صری رز روش  ها و نام ضرریب رست. در ردرمهتعوون آس انه

 شود.می

 های برآورد مقدار آستانهروش 

 .دهدهای م عددی برری رن خاب تعدرد و مکا  مقادیر آسییی انه رررئه میگزینه ریویوز

های  ها شیناخ ه شیده باشید، می تور  آ  رر به عنور  یکی رز گزینهرگر تعدرد آسی انه

 .وررد کرد  "Fixed Number"مرخ  شده  

تعوون  برری   ریویوز درشیی ه باشییود کهتوجه مه  رسییت های دیار، روش  بوا ق ل رز  

 آزمو کند و نه رسی فاده می(  1998) 2شیناسیی بای و پرو رز روش هاتعدرد آسی انه

تری نتی ت به ( که رع  ار ک 1999هانتین )  ثابت پورینهاد شیده توسین بوت رسی را

 
1 Sum of the Squares of the Residuals 
2 Bai and Perron 
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ها رر SSRبرری یک برآورد کلی تخمون آسیی انه،    ( دررد.1998رویکرد بای و پرو  )

های مرسیوم  . روشکندهای ممکن رز مقادیر آسی انه مقایتیه میبرری تمام مجموعه

. در دو شیودضیرریب رگرسیوو  مرت ن رسی فاده می برری تعوون مقادیر آسی انه وزیر 

های روش رول تعدرد آسیی انه ها نامرییخ  رسییت و کاربر باید حدرکثر تعدرد آسیی انه

مجاز رر تعوون کند کند. روش آخر نوز تعدرد مورد نواز آسی انه باید وررد شیود که در  

 شود:ردرمه مرور می

 1در مقابل هو  کدرم   L آس انه های جهانی •

 2حدرقل معوارهای رطلاعات  •

 3تعدرد ثابت  •

با پودر کرد    و  م ورعیهای  آزمو مقادیر آسیی انه همچنون ممکن رسییت به صییورت  

و سیییپس    هیامجموی مربع بیاقومیانیدهآسییی یانیه روعویه، بیه حیدرقیل رسیییانید     ییک مقیدرر

تا   برسیاند  حدرقلرر به  SSR جتی جوی مقادیر رضیافی )با توجه به مقدرر روعوه( که

. شییود، به دسییت آیدتعوون می  آزمو رز طریق   تعدرد آسیی انه مورد نرر که رح مالاً

باز ه ، در دو روش رول، تعدرد   شیود.های زیر رسی فاده میهای م ورعی در روشآزمو 

 های مجاز رر وررد کند وآسی انه ها نامریخ  رسیت و کاربر باید حدرکثر تعدرد آسی انه

 در آخرین مورد، کاربر باید تعدرد دعخوره آس انه رر وررد کند:

 Lدر مقابل   L+1های م وعی شکتت •

 موجود  هاتمام زیر مجموعههای م ورعی آزمو  •

  ورعی )پی در پی( م – تعدرد ثابت  •

 
1 Global Thresholds Versus None 
2 Minimizing the Information Criteria 
3 Fixed number  



 11  ایویوز افزارنرم   اقتصادسنجی کاربردی پیشرفته با

 

124 

 

 بیشتر  برای مطالعه  مرتبطمنابع 

Bai, Jushan and Pierre Perron (1998). “Estimating and Testing Linear Models 

with Multiple Structural Changes,” Econometrica, 66, 47–78. 

Bai, Jushan, and Pierre Perron (2003). “Computation and Analysis of Multiple 

Structural Change Models.” Journal of Applied Econometrics 18(1), 1–22. 

Hansen, Bruce (1999). “Testing for Linearity.” Journal of Economic Surveys, 

13, 551-576. 

Hansen, Bruce (2000). “Testing for Structural Change in Conditional Models.” 

Journal of Econometrics, 97, 93-115. 

Hansen, Bruce (2011). “Threshold Autoregression in Economics.” Statistics 

and Its Interface,” 4, 123–127. 

Potter, Simon (1999). “Nonlinear Time Series Modelling: An Introduction.” 

Journal of Economic Surveys 13, 505–528. 

Tong, H. and K. S. Lim (1980). “Threshold Autoregression, Limit Cycles and 

Cyclical Data,” Journal of the Royal Statistical Society. Series B 

(Methodological), 42, 245–292. 

Tsay, Ruey S. (1989). “Testing and Modeling Threshold Autoregressive 

Processes,” Journal of the American Statistical Association, 84, 231–240  

 

 





 11  ایویوز افزارنرم   اقتصادسنجی کاربردی پیشرفته با

 

118 

 

 

 

 

 

 های ترکیبی : دادههشتمفصل 
 

 

 

 

 

 

 

  



 های ترکیبی فصل هفتم: داده

 

119 

 

 مقدمه

هیا  هیایی وجود دررد کیه در آ  دردهگیاهی در مطیارععیات در حوزه رق صیییادی و میاعی حیاعیت

ها با رسیامی مخ لفی  گونه دردهزمانی و عناصیر مقطعی هتی ند. رینترکو ی رز عناصیر سیری

شیوند. رز بعد  نوز شیناخ ه می  2های طوعییا درده  1پانل، تابلویی  ترکو ی،،  هایرز ق ول درده

هیا دررری ییک وی گی مه  هتییی نید و آ  م  نی بود  آنهیا بر  آمیاری، رین مجموعیه درده

 گوری مریاهدرت به طور متی قل رسیت. ه  پنون رسی قلال، وی گی کلودی تحلولنمونه

وجود هم تییی ای بون جملات رخلال در بون هیای مقطعی رسیییت کیه بیاعیث عیدم  درده

شییود. یک مجموعه درده مقطعی، متیی قلاً آموخ ه با یک نمونه  مرییاهدرت مخ لف می

هیای  گوری رز ییک جیامعیه در زمیا تصیییادفی منفرد م فیاوت رسیییت پرر کیه رح میالاً نمونیه

ه   دهد که به طور متی قل توزیع شیده باشیند. نک ه مدسیت نمیم فاوت، مریاهدرتی رر به

نوز ناموده    3های ترکو ی حاوی رفررد و رشیوا  مریابهی رسیت )که مقطعآ  رسیت که درده

  شوند، مانند کرور، شرکت، بنااه، فرد و ...(.می

هیای  ، رنوری مخ لف روش دردههیای پیانلیدر رین فصیییل بیه بحیث و بررسیییی برآورد درده

   هد شد.ها  مرور خورترکو ی و همچنون موضوعات مرت ن با رین درده

رفزرر ریویوز با رویکرد پانل و برآوردهای آ  ها در نرمرب در ورود دردهدر رب در  در رین بخش 

   شرز درده خورهد شد.

 
1 Panel of Data 
2 Longitudinal Data 
3 Entities 



 11  ایویوز افزارنرم   اقتصادسنجی کاربردی پیشرفته با

 

120 

 

 افزارکار با نرم

 Panelورود داده به صورت 

 برری ورود درده به صورت پانل، به متور زیر رر طی کنود:

File > New > Workfile 

 شود:کادر زیر باز می

 

 Balanceگزینه   Workfile Struture Typeدر قتمت    Panelبرری ورود درده صورت 

Panel   رر رن خاب کنود. در قتیمت ررسیت نوی درده که سیالانه، ماهانه، روزرنه و .... رسیت رر

سییال شییروی درده، در قتییمت    Start Dateمطابق با درده خود رن خاب کنود. در بخش  

End Date  سییال پایا  و در قتییمت  Number of Cross Section ها، تعدرد شییرکت

 کرورها یا رفررد رر رن خاب کنود. کادر زیر به عنور  یک مثال پر شده رست:



 های ترکیبی فصل هفتم: داده

 

121 

 

 

تورنود برری فایل کاری خود یک رس  رن خاب کنود.  می Workfile Nameدر بخش  

عنور   رع  ه پر کرد  رین بخش رعزرمی نوتت و ریویوز در صورت خاعی بود  آ  رس  

 گورد. پوش فرضی برری آ  در نرر می

 رر کلوک کنود. تا فایل کاری ساخ ه شود.  OKسپس 

 تصریح مدل

 های حداقل مربعاتمثال

های پانل نام ورز  ری رز دردهبرری نرییا  درد  برآورد معادلات پانل در ریویوز، رب در نمونه

رین   2شود.در نرر گرف ه می ( برری مطاععه قومت هدرنوک 1978)  1رز هریتو  و روبونفلد

 ( نوز رررئه شده رست.2005ها در ک اب باع اجی )درده

 
1 Harrison and Rubinfeld 

 در سایت ریویوز موجود رست. Harrison_panel.WF1ها با عنور   رین درده 2
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تا   1های گروهی رز شیهر در منطقه بوسی و  با رندرزه 92مریاهده در   506ها شیامل  درده

( رسییت و MVرسییت. م غور وربتیی ه عااری   ررزش ورحد متییکونی مورد رسیی فاده ) 30

 رگرسورها )م غورهای مت قل(، بقوه م غورهای موجود در فایل کاری رست. 

عنور  شیییناسیییه   به  ”TOWNID“رر رن خیاب کنوید و ع ارت   Undated Panelگزینیه  

 ( وررد کنود.Identifier seriesسری )

پانل شیوده به طوری که یک فایل کاری  های کاری بازسیازی میپس رز تغووررت بالا فایل

نام ورز  رست. بخش بالای پنجره فایل کاری تغوور خورهد کرد تا ساخ ار بدو  تاریم که  

صیورت زیر نمایش درده  مریاهده در  هر مقطع رسیت که به 30مقطع و حدرکثر   92دررری  

 شده رست:
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 در مرحله بعد متور:

Quick > Estimate Equation 

 ر باز شود:رر برری تصریح معادعه طی کنود تا پنجره زی

 

شود.   (، معادعه تصریح شده با رس فاده رز رثررت ثابت برآورد می2005با ت عوت رز باع اجی )

و سییایر م غورری پس رز آ  رگرسییورها     C، جز  ثابت MVدر رین مثال م غور وربتیی ه 

 )م غورهای مت قل( هت ند.
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جره تصیییریح معیادعیه در پن  Panel Optionsبرری برآورد معیادعیه بیا رثررت ثیابیت بر روی  

قررر دهوید. بیا کلویک بر روی   Fixedرر بر روی    Cross-Sectionکلویک کنوید و سیییپس  

 ن ایا برآورد با رثررت ثابت رررئه خورهد شد.  OKگزینه  

 

توجه درشی ه باشیود که   . جا نریا  درده شیده رسیتن ایا برری برآورد رثررت ثابت در رین

که دررری تفتیوری مریابه فصیول ق ل رسیت.   رسیت  گزررش شیده   F و R-Squared آمار

کویون( گزررش شییده رسییت. در  –همچنون معوارهای رطلاعات )آکائوک، شییوررز، و هنا   

گر عدم وجود خودهم تیی ای در  ورتتییو  گزررش شییده رسییت که بوا -نهایت دورت ون
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خودهم تییی ای بون زیرر مقیدرر قیابیل ق ول برری وجود عیدم   هیای میدل رسیییت.بیاقومیانیده

 قررر گرف ه رست  9/1-10/2جملات رخلال در آس انه 

در صیورتی که مایل به تغووررتی در تصیریح مدل باشود و یا بخورهود شووه برآورد رر تغوور  

کلوک کنود تا پنجره تصیریح معادعه باز شیود. م غورهای   Estimateدهود، بر روی گزینه  

رر به معادعه رضیافه کنود و سیپس   PTRATIOو   ZN, INDUS, RAD, TAXمتی قل  

قررر دهود تا برآورد به صییورت تصییادفی    Randomبرآورد رر بر روی  Optionرز بخش 

 رر کلوک کنود تا ن ایا به صورت تصادفی رررئه شود:  OKرنجام شود. گزینه  
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به   نت ت  به  که  رس اندررد  خطاهای  با  رر  برآورد  رز  مثال  یک  بعد،  بعدی  گام  در 

  1های وعدریا برری رین مثال، رز درده خودهم ت ای مقاوم شده رست رر نرا  خورهو  درد.

 2شود. ( رس فاده می2002)

 

همانند مثال ق ل باید رب در فایل درده رر به صییورت فایل کاری پانل تنرو  کنود. بر روی 

Range    در رب یدری پنجره کلویک کنوید و ع یارت“YEAR”    ع یارت  رر بیه عنور  زمیا  و

“FCODE”    .رر به عنور  شناسه مقطع وررد کنود 

 

 
1 Wooldridge 

 قابل دس رسی رست.  "Jtrain.WF1"))  ها با عنور رین درده 2
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کنید. رع  یه  تنرو  می  1987-1989مقطع و دوره زمیانی    157ریویوز فیاییل کیاری رر برری  

 تعدردی رز م غورهای در رین بازه زمانی دررری مراهدرت مفقوده هت ند.

 

-5برری برآورد معادعه با رثررت ثابت که نتی ت به خودهم تی ای مقاوم شیده رسیت )مثال  

 ((. متور: 2002وعدریا ) 276در صفحه    10

Quick > Estimate Equation 

 رز بخش منوی ریویوز رن خاب کنود و عوتت تصریح مدل رر رن خاب کنود.  

lscrap c d88 d89 grant grant_1 

 

 Panelتصیییریح معیادعیه رر وررد کنوید و رز بخش    Equation Specificationدر بخش  

Options  مقطع رر بر روی ،Fixed  .قررر دهود 
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در نهایت ممکن رسییت شییما مایل باشییود خطاهای رسیی اندررد مقاوم شییده نتیی ت به 

 Coef Covarianceری  خودهم تی ای رر محاسی ه کنود. برری رین منرور در نورر کرکره

Method    گزینیهWhite Period    رر رن خیاب کنوید. همچنون تویک مربوب بیهNo d.f. 

correction  .برری محاس ه کوورریانس فعال نرده رست 

 رر کلوک کنود تا ن ایا برآورد رررئه شود:  OKگزینه  

 

ها تنرو   توجه درشیی ه باشییود که ریویوز به طور خودکار برری مقادیر گ  شییده در درده

مقطع مورد رس فاده در برآورد وجود دررد. بخش بالای  54مراهده در  162شود. تنها  می
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دهد که ن ایا با رسی فاده رز خطاهای رسی اندررد مقاوم شیده رنجام شیده خروجی نریا  می

دهید کیه ضیییررییب برآورد شیییده  رسیییت. توجیه درشییی یه بیاشیییوید کیه ریویوز هریییدرر می

Covariances  نی رغ می دهد که  رز رت ه کامل ّرخوردرر نوتی ند که رین مورد بوری ر زما

 تر رز تعدرد مقاطع رست. همچنون با کلوک بر روزی متور:  ها ک تعدرد دوره

Quick > Estimate Equation 

رقیدرم کرد. همچنون میمی تور  در همون بخش تور  برری تغوور روش برآورد معیادعیه 

 کنود:تصریح معادعه رر تغوور درد.  تصریح زیر رر در بخش معادعه وررد  

d(lscrap) c d89 d(grant) d(grant_1) 

پینیجیره   بیخیش    Equation Specificationدر  کیرکیره  Optionدر  نیورر  -Crossری  در 

Section    رر بر رویNone    قررر دهود. در بخشPanel Options    روشWhite Period 

رر برری محاسییی ه کوورریانس ضیییرریب فعال کنود.    No d.f. correctionو توک گزینه  

 صورت زیر خورهد بود:ن ایا برآورد به
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های تصیریح برری معادلات پانل رر رررئه ری کامل رز آزمو مجموعه ریویوز های فعلینتیخه

های مدل  ها، رسییی فیاده رز باقومیاندهری برری رنجیام برخی آزمو کننید. یک رره سیییادهنمی

 برآورد شده رست. بر روی متور:

Proc  > Make Residual Series 

توعود شییود.  Residual1ها کلوک کنود تا یک سییری به نام  برری ریجاد سییری باقومانده

( رگر  کنود. ن ایا به Residual1 (1-رر بر روی وقفه مرت ه رول ))  Residual1سییری 

 صورت زیر خورهد بود:

 

رین آزمو  عدم وجود خودهم تی ای بر جملات باقومانده مدل رسیت. رز   1فرضیوه صیفر

رسیت، بنابررین فرضیوه   05/0( بالای  Residual1 (1-)جا که رح مال مربوب به ضیریب  آ 

 درصد رد کرد. 5تور  در سطح خطای  صفر رر نمی

 
1 Null Hypothesis 
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 هایی در زمینه متغیرهای ابزاریمثال

مقطع که توسین وعدریا   22ربزرری مثاعی با  برری نریا  درد  مثاعی در زمونه م غورهای  

 شود.( نوز رررئه شده رست، مرور می2002)

 

  CITYبه عنور  شیناسیه زما  و    YEARفایل کاری برری رین مثال با رسی فاده رز ع ارت  

-1988مقطع و دوره زمانی   22شیود. رین مثال شیامل برری شیناسیه مقطع رسی فاده می

 مراهده رست.  198رست که در مجموی حدود   1980

رر در بخش فرمیا  تیایی  و زد  دکمیه    tslsبرری تصیییریح میدل در مثیال فو  ییا ع یارت  

Enter    :و یا متور 

Quick > Estimate Equation 

 د ریجاد کنود.رر رز منوی رصلی طی کنود. در منوی رصلی یک معادعه جدی
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ری رر رز نورر کرکره  Two-Stage Least Squares و یا   TSLSتورنود روش شیییما می

Method    :رن خاب کنود. ع ارت 

d(luclms) c d(luclms(-1)) d(ez) 

 رر کلوک کنود تا ن ایا رررئه شود.  OKرر در پنجره تصریح معادعه وررد کنود و گزینه  

 

رست زیرر طول دوره زمانی نوز به عنور    8زرر در رین معادعه  توجه درش ه باشود که رت ه رب

 ربزرر رس فاده می شود.
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 های ترکیبی همجمعی در دادهریشه واحد و 

های ترکوی  های ترکو ی وهمچنون در دسیی ر  بود  دردهرشیید مطاععات در زمونه درده

ی شیییده هیای ترکو هیای آمیاری مخ لف مرت ن بیا دردهموجیب تیاکوید بر گتییی رش آزمو 

های همجمعی م مرکز شیده رسیت. در منوی آزمو  همجمعی  ردبوات رخور بر آزمو  رسیت

آزمو  ریویوز  پییدرونیدر  )1999)  1هییای  پییدرونی  کییائو2004(،  آزمو  1999)  2(،  و   )

Type-Fisher  ،(. در فصیل  1999 3با رسی فاده رز روش یوهانتین وجود دررد )مادرلا و وو

های ریتی ایی شید. در رین فصیل مروری مخ صیر بر  ق ل مروری بر ریریه ورحد و آزمو 

های مورد  های ترکو ی خورهد شیده زیرر ممکن رسیت سیریدر درده  4های همجمعیآزمو 

رو برری بررسییی ی ریتیی ا ن اشییند. رز رینهای ترکو ی همارسیی فاده در برآورد مدل درده

 شود.های همجمعی رس فاده میوجود یا عدم وجود رگرسوو  کاذب رز آزمو 

حل م درول برری مانا کرد  یک سیری زمانی ناریتی ا به یک سیری زمانی ریتی ا،  یک رره

گوری رسییت. در رین حاعت، برری رهایی رز رگرسییوو  کاذب  رسیی فاده رز روش تفاضییل

  رز تفاضیل مرت ه رول یا تفاضیل مررتب بالاتر م غورها در برآورد مدل رسی فاده کرد. تورمی

های رق صیادی بررسیا  رربطه بلندمدت بون سیطح م غورها بوا  شیده رما بوری ر تئوری

رسیت. رز طرفی دیار زمانی که رز تفاضیل م غورهای سیری زمانی در برآورد مدل رسی فاده  

همون دعول، رسیی فاده رز رود. بها سییطح م غورها رز بون میشییود، رطلاعاتی در رربطه بمی

تفاضیل م غورها در برآورد پاررم رهای مدل، م درول نوتیت. بعد رز رررئه مفهوم همجمعی  

تور  رگرسیوو  رر بدو  تر  رز کاذب بود  بررسیا  سیطح  مولادی، می  1980در دهه  

 
1 Pedroni 
2 Kao 
3 Maddala and Wu 
4 Co-integration Tests 
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  1برآورد کرد )رنیدرز، م غورهیای سیییری زمیانی بیه شیییرب وجود همجمعی بون م غورهیا،  

2004.) 

 های ترکیبی در داده  های ایستایی نحوه انجام آزمون

طور که در  ها هما های ترکو ی پس رز ورود دردههای ریتی ایی در دردهبرری رنجام آزمو 

 کنو :فصل سه توضوح درده شد به صورت زیر عمل می

نجام دهو ، دوبار کلوک کرده  خورهو  آزمو  ریتی ایی بر روی آ  ربر روی م غوری که می

 کنو :و متور زیر رر طی می

View > Unit Root Test 

 شود:سپس کادری به صورت زیر باز می

 
1 Anders 
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های ریت ایی )مانند دیکی فوعر، فولوپس پرو ، رنوری مخ لف آزمو   Summaryدر بخش 

ها رر درشیی ه  عون و عوین و...( وجود دررد. در صییورتی که قصیید رنجام صییرفاً یکی رز آزمو 

کنو . پنانچه بخورهو  ن ایا تمامی  باشیو  رز رین قتیمت آزمو  مورد نرر رر رن خاب می

 کنو .  می okرفزرر بدو  تغوور  خود نرم  Defaultها رر درش ه باشو  هما  گزینه  آزمو 

(  و حیاعیت فقن عرض رز Levelهیای در سیییطح )خود نرم رفزرر درده  Defaultدر منوی  

ها رر بت ه به درده و یا درجه  تور  رین گزینه( قررر دررد. میIndividual interceptم در )

( ریره ورحد Trendریت ایی تغوور درد. مثلاً ممکن رست م غوری با در نرر گرف ن روند )

ندرشی ه و در زور رینصیورت ریریه ورحد درشی ه باشید. یا م غوری در سیطح مانا ن اشید رما 

 آ  ریت ا باشد.  (1st Differenceتفاضل مرت ه رول )

در مثال فصیل پهارم   2COبه عنور  مثال در صیورتی که هدف بررسیی ریتی ایی م غور  

 باشد به پس رز طی متور
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View > Unit Root Test 

 کنو :رر کلوک می  OKگزینه  

 

ناریتی ا رسیت )زیرر فرضیوه   2COها، م غور  دهد که بر رسیا  تمامی آزمو ن ایا نریا  می

0H که م غور با رد نریده رسیت(. برری تعوون درجه ریتی ایی م غور یا به ع ارتی تعوون رین

 کنو :شود به صورت زیر عمل میگوری ریت ا میپندبار تفاضل

 پس رز طی متور

View > Unit Root Test 

رر    1st Differenceگزینه   Test for unit Root Test inدر کادر باز شیده در قتیمت  

 د.  کلوک کنو
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 کنو :رر کلوک می  okدر ردرمه دکمه  
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صیدم رسیت  5های ریتی ایی زیر   که رح مال مربوب به آزمودر رین حاعت با توجه به رین

های با م نی بر وجود ریریییه ورحد رر رد کرده به ع یارت دیار درده 0Hتور  فرضیییویه  می

 1رند.گوری ریت ا شدهبار تفاضلیک 

 های ترکیبی همجمعی در دادههای نحوه انجام آزمون

باشید که در    Panelو یا    POOLتورند در محون  های همجمعی در ریویوز میرنجام آزمو 

نوز  POOLرسیت و برری رنجام آزمو  در محون    Panelها در محون  جا تمرکز آزمو رین

بر رسیییا    Kao و  Pedroniهایگورد. آزمو برآورد کاملاً مریییابه رین حاعت رنجام می

نوز،   Fisherآزمو    .( رسیت1987ها( رنال گرنجر )ماندهری )بر پایه باقیآزمو  دو مرحله

 یک آزمو  ترکو ی یوهانتن رست.

هیای نجره آزمو هیای پیانیل رر بیاز کنوید. برری رسیییویده بیه پرب یدر فیاییل کیاری برری درده

 همجمعی متور زیر رر طی کنود:

View > Cointegration Test > Panel Cointegration Test 

 
 شود.ناموده می I(0)ری که در سطح ریت ا باشد  و درده I(1)شود گوری ریت ا  بار تفاضلری که با یکدرده 1
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 شود.های مخ لفی وجود دررد که به ترتوب مرور میدر پنجره باز شده گزینه

 Test Typeبخش  

ری یکی رز سییه آزمو  همجمعی  های همجمعی در نورر کرکرهدر رین بخش رز بون آزمو 

شیییود. بیا رن خیاب هر ییک رز رسیییت، رن خیاب می  Fisherو    Kao  ،Pedroniکیه شیییامیل  

 کند.  های همجمعی، پنجره آزمو  نوز تغوور میآزمو 

تر  یا ک  7های که شیامل  های دردهفقن برری گروه Pedroniتوجه مه : آزمو  همجمعی  

م غور آزمو  پیدرونی در پنجره    7ادیر بیالای  رز هفیت سیییری )م غور( دررنید. و برری مقی 

 شود.آزمو  ریره ورحد رررئه نمی

های  بتیوار شی وه به گزینه Kao و Pedroni هایهای قابل تنرو  مرت ن با آزمو گزینه

 موجود در آزمو  ریره ورحد پانل رست که در فصل سوم مورد بحث قررر گرف ه رست.
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، م غورهیای متییی قلی کیه بیایید در  Deterministic Trend Specificationدر بخش  

قررر باورنید رر مریییخ  کنوید. در رین حیاعیت برری آزمو    1ریرگرسیییوو  دو مرحلیه

 Individual Intercept  ،Individual Interceptسیییه گزینیه      Pedroniهمجمعی  

and Individual Trend    و ییا گزینیهNo intercept or trend   رر رن خیاب کنوید. بیه

کند. گزینه دوم علاوه بر رثررت ثابت زینه رول فقن رثررت ثابت فردری رر عحای میترتوب گ

گورد. گزینه سییوم نوز بدو  رثررت ثابت و روند فردی  فردی، روند فردی رر نوز در نرر می

 گورد.رنجام می

ری رسیت. رگر گزینه  ها در رگرسیوو  دو مرحلهنوز شیامل تعدرد وقفه Lag lengthبخش 

Automatic Selection    رر رن خاب کنود، ریویوز به طور رتوماتوک تعدرد وقفه رر بررسیا

کنید. در بخش پیایونی همون گزینیه بیا کوئون وررد میمعویارهیای آکیائویک، شیییوررز و هنیا 

حدرکثر وقفه     تورنود حدرکثر تعادر وقفه رر مریییخ  کنود.می  Maximum Lagعنور   

 شود:با رس فاده رز رربطه زیر محاس ه می Cross-Sectionبرری 

 

 ، تعدرد مقاطع رست.iTجا  در رین

، وقفه مورد نرر User specifiedجای فرریند بالا رز گزنه شیما همچنون ممکن رسیت به

هر دو برآورد پیاررم رییک و   Pedroniخود رر بیه صیییورت دسییی ی وررد کنوید. آزمو   

 دهد.  رر برری محاس ه ورریانس بلند مدت مورد رس فاده قررر می  Kernelناپاررم ریک  

 
1 Second-Stage Regression 
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تور  دهید. میتنرومیات برآورد نیاپیاررم رییک رر رررئیه می Spectral Estimationدر بخش 

(  Bartlett, Parzen, Quadratic spectralهیای مخ لف در رین حیاعیت )رز بون گزینیه

 یک گزینه رر رن خاب کرد.  

 رز طریق رربطه:  Newey-West fixed bandwidthگزینه  

  

 ن ایا برآورد رررئه خورهد شد:  OKشود. با کلوک بر روی گزینه  محاس ه می

 

های همجمعی، عدم وجود آماره رسیت. فرضیوه صیفر تمام آزمو  7شیامل    Pedroniآزمو  

 05/0تر رز همجمعی رسییت. بنابررین در صییورتی که مقدرر رح مال آماره محاسیی اتی ک 

آماره فو  تنها دو گزینه   7شیود. رز  باشید، فرضیوه صیفر رد و وجود همجمعی پذیرف ه می
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 5شیییود برری رسیییت و وجود همجمعی رد آ  پیذیرف یه می  05/0رول دررری رح میال زیر 

 تور  فرضوه صفر رر رد کرد.  آماره دیار نمی

رین  Pedroni برری آزمو  دهید.بخش پیایون جیدول، ن یایا مقطعی کمکی رر نریییا  می

پررو   -بخش رول شامل ن ایا زور پاررم ریک فولوپس شود،گزینه به دو بخش تقتو  می

 .دهدرر نرا  می فوعر-دیکی رست و بخش دوم ن ایا پاررم ری پوررف ه

 

 رررئه شده رست:  Fisherدر ردرمه تنرومات مروبن به آزمو   
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د خیارجی مورد رسییی فیاده رر ، نوی رونی Deterministic Trend Specificationبخش  

، برری تعوون تعیدرد وقفیه مورد نویاز در برآورد Lag Intervalکنید. بخش  مریییخ  می

رر کلوک کنود که تفتییور ن ایا مرییابه   OKگورد سییپس گزینه  مورد رسیی فاده قررر می

 رست.   Pedroniآزمو  

 (PMG)  1برآوردگر میانگین گروهی تلفیقی 

به صییورت    دررد، بزرگ  نتیی  اً  زمانی  بخش سییری   ههای پانلی کدر حال حاضییر درده

رگرسیوو  سیری زمانی    Nتور   می  حاعت رین  گورد. درری مورد رسی فاده قررر میگتی رده

  ی قوتلف   یگروه  نواناوبرآوردگر م. با ها رر محاسیی ه نمودمواناون آ   در ردرمهو   کردرجرر 

(PMG  )که ضیییرریب شیییوب و ورریانس آنها   نمودو فرض  کرد  ها رر ترکوب تور  دردهمی

، رین روش رر ARDLبا توسیعه روش   (1997)  و رسیموت  مریابه هتی ند. پتیرر ، شیون

شیوند رما رجازه درده می  در رین روش ضیرریب شیوب بلندمدت مریابه فرض میرررئه کردند.  

ها در بون ورحدهای مقطعی تغوور شیوب کوتاه مدت و رنحررف معوار آ   شیود که ضیرریب

 
1 Panel Mean Group 
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مجان ی رین برآوردگر زمانی که بعد زما     هایگی وی (1997)  پتیییرر  و همکارر   کنند.

در حاعت ریره ورحد بود  ه   و  م غورها  ریت ایی  حاعت در ه  رودنهایت میبه سمت بی

در ردرمه مثاعی    .ندورحدهای مقطعی ثابت رسیییت بررسیییی نمود  دتعدر  که  زمانیم غورها  

 شود.کاربردی برری درک به ر روش بررسی می

 افزارکار با نرم

 OECD برآورد توربع مصیرف در کریورهای های رسی فاده شیده برریدر رین مثال رز درده

 1شود.  رس فاده می 1993-1962های  در سال

 در ریویوز متور زیر رر طی کنود:  PMGبرری برآورد به روش 

Quick > Estimate Equation 

رر رن خاب کنود. بخش تصیریح معادعه     PMG/ARDLگزینه   Methodsسیپس رز بخش 

 رر با رس فاده رز معادعه:  

log(cons) log(inf) log(inc) 

 پر کنود.

رر رن خیاب کنوید. سیییپس تعیدرد    Fixedگزینیه    Dynamic Specificationدر بخش  

بر روی   Dependent Variable Lagsبخش  ریهای م غور وربتی ه رر رز نورر کرکرهوقفه

تغوور درده    ”1993 1962“نوز بیه    Sampleییک قررر دهوید. دوره زمیانی برآورد در بخش  

 
 در سایت ریویوز قایل مراهده رست.  ”OECD.wf1“های رین بخش تحت عنور  درده 1
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رر برری برآورد معادعه کلوک    OKها رر بدو  تغوور باذررید. گزینه  شیده رسیت. سیایر آی  

 صورت زیر خورهد بود:کنود. ن ایا به

 

و رربطیه کوتیاه میدت     (Long Run Equationرربطیه بلنیدمیدت )در پنجره برآوردی،  

(Short Run Equation  رررئه شیییده رسیییت. در رربطیه بالا کریییش بلنید مدت م غور )

LogInc   1شده رست. 904/0برربر با 

 
های  شییود، ضییرریب برآوردی مفهوم کرییش رر خورهند درشییت. مدلزمانی که رز دو طرف معاعه عااری   گرف ه می 1

ی  هاتر هتی ند. همچنون مدلهای زور عااری می برری پورینهادرت سیواسی ی مناسیبکریش ثابت نتی ت به مدل

 کنند.تر رر موتر میعااری می با کاهش درمنه تغووررت م غورها، رمکا  حصول ن ایجی به ر با تورش ک 
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 های ترکیبی های تکمیلی در دادهآزمون

هیای پیانیل دی یا رسیییت. برری  در ررت یاب بیا برخی م یاحیث تکمولی در زمونیه درده  بخشرین  

نمودررهیا، آزمو  هیای وربتییی ای مقیاطع و همچنون  رین منرور آمیارهیای توصیییوفی، 

 گورد.  هم ت ای سریاعی رز درجات مخ لف مورد بحث و بررسی قررر می

 نمودارهای سری زمانی 

 نی. رز رکندرر رررئه می  پانل یزما  با درده ها یسر  ینمودررها  شینما یبرر یربزررریویوز، 

  هر مقطع   یبرر  ی وترک  ایی   یفرد  ی، نمودررهیاپیانلی  یهیادرده  ینمودرریش  نمیا  یربزررهیا برر

 کرد.رس فاده  

  ، یکار  لیفا  ک یدر   هایرز سییر  یگروه  ای یسییر  ک ی یبرر  یپانل  ینمودررها  شینما یبرر

 و متور زیر رر طی کنود:  دوگروه باز کن  ای یپنجره سر

View / Graph ...  

. در بخش رن خیاب کنویدرر    Dialog Options Graphپنجره    و سیییپس  دوی کن  ک وی کل

Panel options  یاونا پ یبرر  یمخ لف   یهانهیگز  ریویوز،  محاوره  نیودر سمت ررست پا  

 دهد.یها رررئه مدرده  شینما
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ف و رنوی مخ لف نمودررهیا، گزینیه مورد هیای مخ لتورنوید رز بون گزینیهدر رین بخش می

برری مثیال بیا رن خیاب   نمودرر زیر رر خورهو    Line & Symbolنرر رر رن خیاب کنوید. 

 درشت:
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رر رن خاب کنود، نمودررهای    Individual cross sectionsصییورتی مرییابه رگر گزینه  به

مقطع   10سییری زمانی برری هر مقطع قابل مرییاهده رسییت. در ردرمه رین نمودررها برری 

 مورد بررسی رررئه شده رست:

 

 .دوکن یبررس نااه  ک یسازد تمام مقاطع خود رر در  ی، نمودرر شما رر قادر محالنیبا ر

هر   یبرر  توصیوفیآمار    یدرر ورحد حاونمو  ک یدهد  یمانده به شیما رجازه میباق   نهیدو گز

   .دوکن  بررسیدوره رر 
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رر رن خاب کنود:   Mean plus SD boundsدر خن نمودرر، شییما ممکن رسییت گزینه  

 (.  3و یا   2،  1رر رن خاب کنود ) .Std.Devری  تعدرد  سپس رز نورر کرکره

رن خاب کنود و سیپس رز   Median plus quantilesهمچنون در خن نمودرر رگر گزینه  

 رر رن خاب کنود.    extreme quantilesری مقادیر  نورر کرکره

 

 2( موانه و Fجا سییری  فرض کنود در دو حاعت بالا، برری سییری مورد رسیی فاده )در رین

 صورت زیر خورهد بود:رنحررف رس اندررد نمایش درده شود. ن ایا به
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 صورت زیر خورهد بود:و در صورت رن خاب موانه، ن ایا به
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 آمار توصیفی 

های مورد رسییی فیاده در یک فایل کاری پانلی  برری درشییی ن یک دید کلی در زمونیه درده

تورنوید پس رز بیاز تورنوید بیه آمیار توصیییوفی م غورهیا مررجعیه کنوید. برری رین منرور میمی

 کرد  سری موردنرر، متور زیر رر طی کنود:

View > Stats by Classification ... 

 شود:پنجره زیر باز می

 

تورنوید مورردی میاننید ، مویاناون، مجموی، مویانیه، میاکزیم  و ... رر در پنجره بیاز شیییده، می

های مواناون، رنحررف رسیی اندررد و تعدرد  عنور  مثال در پنجره بالا گزینهرن خاب کنود. به

 مراهدرت رن خاب شده رست. 
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ل باشیود ن ایا آمار توصیوفی برری هر مقطع نوز رررئه در صیورتی که مای  نکته بسییار مهم:

 crossid@، دسی ور  Series/ Group for Classifyشیود در همون پنجره و در بخش 

رر وررد کنوید. در رین صیییورت ن یایا آمیار توصیییوفی برری هر مقطع و همچنون برری کیل  

 شود.نمونه رررئه می
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اناون مقاطع هتی ود، متیور زیرر رر طی  در صیورتی که مایل به بررسیی آزمو  برربری مو

 کنود:

View < Equality Tests by Classification... 

 برری رین منرور سری مورد نرر رر باز کنود و سپس متور زیرر رر طی کنود:

View > Descriptive Statistics & Tests   <  Equality Tests by 

Classification.... 

رر کلویک    OKرر وررد کنوید و سیییپس    Series > Group for Classify  ،FNدر فولید  

 رررئه خورهد شد:  Fبرری سری   ANOVAکنود. ن ایا آزمو  
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 کوواریانس 

 صورت زیر عمل کنود:های پانلی، بهبرری محاس ات کوورریانس در درده
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رر رن خاب کنود. پنجره    Panel Covarianceو سییپس    Viewمطابق شییکل بالا، گزینه  

 شود:زیر باز می
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رر   OKتورنوید رن خیاب و سیییپس گزینیه  شیییود. موررد مورد نرر رر میپنجره پیائون بیاز می

 کلوک نمائود.  

 

 صورت زیر رررئه خورهد شد:ن ای  به
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 دهد.  متور بالا هم ت ای بون مقاطع رر برری م غور مورد بررسی نرا  می

( رر رنجام دهود، پنجره باز Periodsها )مایل باشییود کوورریانس بون زما در صییورتی که  

 شده رر مطابق شکل زیر پر کنود:
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 1972“رر کلویک نمیائوید، ماتریس هم تییی ای بون زمانی )  OKدر صیییورتی که گزینیه  

 ( رررئه خورهد شد.”1992

 1واریانس بلندمدت پانل

های پانلی و زور کوورریانس بلند مدت در دردههای جزئی در محاسیی ات ورریانس و  تفاوت

 و     LCARPCAPپیانلی وجود دررد. در مثیال مورد بررسیییی ییک گروه رز دو سیییری  

LGASPCAR:ترکول شده رست. پس رز باز کرده دو سری فو ، متور زیر رر طی کنود 

View > Long-run Covariance 

 رر وررد کنود.    ”pan_results“، ع ارت  Panel Matrixبرری نمایش پنجره در بخش 

 
1 Panel Long-Run Variances 
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 رر کلوک نمائود:  OKسپس  

 

 صورت بالا خورهد بود:ن ایا به

 ذخوره خورهد شد.   PAN_RESULTSن ایا رنفرردی برری مقاطع ه  در سری  
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 های وابستگی مقاطعآزمون

 کند:ریویوز برری بررسی وربت ای بون مقاطع پندین آزمو  به شرز زیر رررئه می

Breusch-Pagan (1980) LM 

Pesaran (2004) scaled LM 

Baltagi, Feng, and Kao (2012) bias-corrected scaled LM 

Pesaran (2004) CD 

 برری بررسی وربت ای مقاطع، پس رز برآورد مدل، متور زیر رر طی کنود:  

View > Residual Diagnostics > Cross-section Dependence Test 
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 صورت زیر رررئه خورهد درد:متور بالا، ریویوز ن ایا آزمو  وربت ای مقاطع رر بهبا طی  
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ها رسیت. در صیورت رد  فرضیوه صیفر رین آزمو  عدم وربتی ای بون مقاطع در باقومانده

 1شود.فرضوه صفر، وربت ای بون مقاطع پذیرف ه می

 2آزمون همبستگی سریالی آرلانو و باند

، بیایید پس رز برآورد میدل، ن یایا  GMMهیا بیا رسییی فیاده رز روش  برآورد میدلدر هنایام  

خودهم تی ای مرت ه رول، دوم و یا بالاتر رر آزمو  کنود.  ری آزمو  توسین آرلانو و بوند  

برری رنجام آزمو  فو ، پس رز برآورد مدل، متیور زیر رر طی   ( رررئه شیده رسیت. 1991)

 کنود:

 
  95)  خطا  05/0باشید فرضیوه صیفر در سیطح    05/0زیر    Probهای آماری در ریویوز در صیورتی که موزر   در آزمو  1

 شود.رد می  درصد رطمونا (
2 Arellano-Bond Serial Correlation Testing 
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View > Residual Diagnostics > Arellano-Bond Serial Correlation Test 

 

 

وجود  2وجود دررد رما رز درجه   1، هم تیی ای سییریاعی رز درجه  Probبا توجه به مقدرر  

 ندررد.  

 آموزش دانلود داده از منابع معتبر

آوری درده برری یک پرویه کلاسیی زاع ا آموزنده، جاعب و برخی مورقع مریکل رسیت. جمع

ری برری پاسییم به سییورلات تحقوق لازم  گوری کنود په نوی دردهتصییمو  شییما باید رب در

ها وجود دررند که  های مخ لفی رز دردهرسییت. در ردرمه توضییوح خورهو  درد که مجموعه

هیای مقطعی  هیای مقطعی، سیییریهیای زمیانی، دردهترین رنوری آنهیا ع یارت رز دردهعمومی

تورنند به کمک هر یک رز ساخ ارهای  دی میهای ترکو ی رست. سورلات زیاآموخ ه و درده

ری ذکر شییده در بالا پاسییم درده شییوند. برری مثال، برری مطاععه در مورد رین که آیا درده

ها مقطعی شیهرهای  شیود رر به کمک دردهفریارهای قانونی بوری ر منجر به جرم کم ر می

هرها )که شیامل های ترکو ی شی های سیری زمانی یک شیهر خا  و یا دردهمخ لف، درده

گوری در  های تعدردی شیهر مریخ  طی دو سیال یا بوری ر رسیت( رنجام درد. تصیمو درده
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هایی که جمع خورهند شیید بتیی ای به نوی تجزیه و تحلول ما دررد. برری  مورد نوی درده

پاسیم به سیورلات مربوب به رشیخا  یا خانوررها، رزلب به یک درده مقطعی تکی دسی رسیی 

تور  آید. سیپس باید پرسیود آیا میهای مودرنی به دسیت میز طریق روشدرری  که نوعا ر

آوری کرد که به کمک آ  تحلولی مع  ر رنجام درد   مجموعه درده نتییی  ا بزرگی رر جمع

خورهود بدرنود آیا خانوررهایی که رز طریق صندو  بازنرت ای  برری مثال، فرض کنود می

رندرز در برخی رزکریورها دررری مزیت ماعواتی رسیتهپرر  کنند )رین روش پسرندرز میپس

ها دررری مزیت شیود( نتی ت به سیایر روشرندرز رز رین طریق مریمول ماعوات نمیکه پس

رندرز رز رین طریق دررری نرغ بازدهی  بورییی ری هتییی ند یا خور. به ع ارتی دیار، آیا پس

کنندگا   های ماعی مصییرفردهری زیادی مانند دهای دردهبوریی ری رسییت یا نه  مجموعه

رنیدرز برری خیانوررهیا رسیییت هیای مخ لف پسوجود دررد کیه حیاوی رطلاعیاتی در مورد روش

ها متیییایلی به وجود ری هتییی ند(، رسییی فاده رز رین مجموعه)م  نی بر آمارگوری نمونه

  های کافی بر م غورهایی مانند آورند که شییاید مهم رین آنها رین رسییت که آیا کن رلمی

شییناسییی و بدیل سییلایق رفررد وجود دررد. رگر تنها  موزر  درآمد، خصییوصییوات جمعوت

مجموعه در دسی ر  همون مجموعه فعلی رسیت، باید رقدرمات لازم در مورد آ  رر رنجام  

 درد.

ها، ریالات و نرایر آ  وجود های مقطعی بنااهمتیایل مریابهی در رربطه با رسی فاده رز درده

های یک مقطع  رد مریخ  نوتیت که آیا می تورنود با رسی فاده رز دردهدررد. در بوری ر مور

خا  تحلول مع  ری رنجام دهود یا خور. برری مثال، در بررسییی رثر فرییارهای قانونی بر  

زریی مخار  رین فریارها رر در مدل تریخو  درده و کن رل  وقوی جرم، باید مریکل درو 

کنود، بتیوار مریکل رسیت ونی رسی فاده میهای رسی اندررد رگرسیوکنود. زمانی که رز روش

نرر رز رین که په تعدرد رقدرم کن رعی  ما  مطمئن شیوید، صیرفکه رز مع  ر بود  تحلول

شییوند. برخی رز آنها ها در رشییکال گوناگونی ررریه میرید. رین سییاعنامهرر در پوش گرف ه
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رت پرینت شییده  های بزرگ( تنها به صییوهای سییری زمانی )مجموعه دردهخصییوصییاً درده

ها رز منابع پرینت شیده  های کوپک، وررد کرد  دردهشیوند. برری مجموعه دردهمن ریر می

به کامپووتر توسیین شییما، مطمئن و قابل مدیریت خورهد بود. برخی رز مورقع مقالاتی به 

های زمانی(  های کوپک )خصییوصییا سییریرسییند که در آنها رز مجموعه دردهپاا می

های  های تکمولی به خصییو  دردهتورنند با دردهرین مقالات میرسیی فاده شییده رسییت. 

 های رخور تکمول و دوباره رنجام شوند.سال

ها نوز به صیورت رعک رونوکی در دسی ر  هتی ند. بتیواری رز سیایت های بتیواری رز درده

کننید. رزلیب،  هیای خود مینهیادهیای دوع ی رقیدرم بیه رن ریییار نتیییخیه رعک رونویک درده

های رسیی فاده شییده در مطاععه خود رر به صییورت  نویتییندگا  مقالات تمایل دررند درده

های زیادی روی رین رنت در دسیی ر  هتیی ند. به رعک رونوکی ررریه نمایند. مجموعه درده

های مورد نواز رسییت. به ترین منابع دسیی وابی به دردهبوانی دیار، رین رنت یکی رز عمومی

ها  سیایتگویند. بتیواری رز وب 1های رطلاعاتی آنلاینعاتی، بانک های رطلارین گونه بانک 

های  سیییایتترین وبدر ردمه مه کنند.  های رق صیییادی یا مرت ن به آ  رر توعود میدرده

ها  رق صییادی، ماعی و رج ماعی در ریرر   و خار  رز کرییور شییرز درده  رررئه دهنده درده

 شده رست.

 ئه دهنده آمارهای اقتصادیهای خارجی اراترین سایتمهم

شیود و در ردرمه نحوه  های رررئه دهنده آمارهای رق صیادی رررئه میترین سیایتدر رب در مه 

های رق صیادی  ترین مرجع برری دردهسیایت بانک جهانی به عنور  کاملدرنلود درده رز وب

 شرز درده خورهد شد.

 
1Online databases 
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 سایت بانک جهانی وب

 دوره  در  دنوا  کرییورهای  تمامی برری  آماری  خام  هایدرده رز  وسییوعی  یدررری گتیی ره

  یک  در و  شییده  آوریجمع  سییاعه هر  هادرده رین رسییت  ذکر به  لازم تاکنو  رسییت، 1960

 به په و آنلاین  صییورت به  په  رطلاعاتی  بانک  رین   بنابررین  شییودهمی  تکثور نوز  دی.سییی

ترین من ع برر  بانک جهانی به عنور  کامل . فاده رسییترسیی   قابل  دیتییک   هارد  صییورت

م غور    1000های رق صیادی، برری حدود دویتیت کریور دنوا و برری هر کریور حدود  درده

 دهد.آدر  سایت بانک جهانی به صورت زیر رست:رق صادی و رج ماعی رررئه می

www.worldbank.org 

 Nation Masterسایت وب

وی گی   درررسیت،  دنوا  کریورهای  تمامی برری  رر  آمارها رز  وسیوعی   یرین سیایت نوز گتی ره

  م غورها  بون آنلاین  صییورت به  تورندسییایت رین رسییت که رسیی فاده کننده میرین وب

وی گی  .  مربوب به م غورها رر رس  کند م درده و یا نمودرررنجا  ساده  هم ت ای  هایتحلول

  م غورهای  به مربوب  بتییواری رز آمارهای  رین رسییت که  سییایتوب  خا  مربوب به رین

 به صورت زیر رست:  Nation Masterسایت  کوفی رر گردآوری کرده رست. آدر  وب

www.nationmaster.com  

 OECDسایت کشورهای 

رسیت و دررری رطلاعات رق صیادی رج ماعی دقوقی رز  OECDسیایت مربوب به کریورهای  

ای مربوب به رین سییایت فقن برری کرییورهای  هبتییواری رز درده  .باشییدرین کرییورها می

OECD    موجود رسیت و برری سیایر کریورها موجود نوتیت. رین سیایت مرجعی کامل برری
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به صیورت زیر  OECDآشینایی با سیاخ ار رق صیادی رین کریورها رسیت. آدر  سیایت  

 رست:

www.oecd.org 

 UNCTADسایت وب

گذرری خارجی و سیرمایهلی در زمونه  بتیوار کامرطلاعات   تورنودمیشیما  سیایت  وبدر رین 

کنود. آدر    دنوا  کریورهای  تمامی برری  … و   گذرری متی قو  خارجیدرخلی، سیرمایه  

 به صورت زیر رست:  UNCTADسایت  

www.unctad.org 

 Penn World Dataسایت  وب

آدر    .ریکا رر بوابودآم به وی هتورنی آمار رق صیادی کریورهای دنوا و در رین عونک ه  می

 به صورت زیر رست:  Penn World Dataسایت  

www.bized.co.uk 

 ILOسایت سازمان جهانی کار وب

سیازما  جهانی کار، رز رین عونک می تورنود تمامی، آمار و رطلاعات مربوب به نوروی کار   

 .دست آوردیده و تمام موررد جان ی مربوب به آ  رر ب

www.ilo.org 

 



 11  ایویوز افزارنرم   اقتصادسنجی کاربردی پیشرفته با

 

168 

 

 های داخلی سایت

های رقنصیادی و ماعی در ریرر  در سیایت بانک مرکزی ریرر  و مرکز آمار ریرر  عمده درده

 رست.موجود 

 بانک مرکزی

f  رنک مرکزی ریرر  جهت نول به رهدرف خود که همانا کن رل تورم و توسییعه رق صییادی

کند که رین آمارها  می  رق صیادی  آمارهای  رز  وسیوعی طوف  تهوه و  گردآوری رسیت، رقدرم به

های قومت، گزررش بررسییی بودجه خانورر، آمارهای  طور عمده شییامل رنوری شییاخ هب

همچنون در رین . های خدماتی رسیتهای سیاخ مانی و آمار فعاعوتفعاعوتصینع ی، آمار  

های ملی سیالانه رز های ملی فصیلی و حتیابهای ملی ریرر  شیامل حتیاببخش حتیاب

  www.cbi.irآدر  سیایت مرکز آمار ریرر  نوز   .تا کنو  رررئه شیده رسیت 1338سیال  

 قابل دس ر  رست.  www.tsd.cbi.ir رست و بخش سری زمانی نوز در آدر   

 مرکز آمار ایران

و رن ریار آمارهای رسیمی کریور و رسی قررر نرام    تهوه، مدیریت  مرکز آمار ریرر ماموریت  

آدر  سیایت مرکز آمار  م نا با رعایت رصیول بنوادین آمارهای رسیمی رسیت.آمارهای ث  ی

 ست.ر    www.amar.org.irریرر  نوز 

 مرکزی ایران آموزش شیوه دانلود داده از بانک

برری درنلود درده رز بیانیک رطلاعیات سیییری زمیانی بیانیک مرکزی ریرر  رب یدر وررد آدر  زیر 

 شوید:

Tsd.cbi.ir 
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 شود:با ورود به آدر  فو  پنجره زیر باز می

 

رر برری بخش لاتون    Enterرر برری بخش فارسییی و گزینه    ورودرز صییفحه فو  گزینه  

 کلوک کنود:

 شوید:وررد صفحه زیر می
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کلوک کنود   +رب در بخریی که مایل به دریافت درده آ  هتی ود مریخ  کنود و بر روی  

ها و جزئوات آ  باز شیود. به عنور  مثال در صیورتی که مایل به دریافت درده  تا زیربخش

GDP  شوید:هت ود وررد بخش حتاب های ملی به صورت زیر می 

 

  1390و سییال   1383،  1376ری سییال  های ملی به سییال پایه بردر رین بخش حتییاب 

شیوید. برری   1390باشید. وررد یک بخش دعخوره، بعنور  مثال بخش سیال پایه  موجود می

 کنار آ  رر کلوک کنود: +رین کار گزینه  
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هتی ند. با کلوک   درنلودآزاز موریوند، دررری مقدرر بوده و قابل        عناوینی که با تصیویر

ربوطه به عوتیت عناوین رن خاب شیده در رین پنجره رفزوده روی هر یک رز موررد، عنور  م

 شود.  می

 

رر رز پنجره    "نمیایش گزررش"س رز رینکیه عنیاوین موردنرر خود رر رن خیاب کردید، دکمیه  پ

  "دقیت کنوید. در پنجره    زیررن خیاب کنوید. بیه عنور  نمونیه بیه شیییکیل    "عنیاوین برگزییده  "

که زیر   "نمایش گزررش"رند . با فریرد  دکمه  هسیه عنور  برگزیده شید  "عناوین برگزیده  

 :شودباز می زیررین عناوین قررر دررد صفحه جدیدی مرابه شکل  
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شیود  رین رن خاب باعث می  شیود.ری مورد نرر رن خاب میدر رین صیفحه تورتر و بازه سیالانه

رطلاعیات آمیاری عنیاوین رن خیاب شیییده تنهیا در تورتر و دوره زمیانی موردنرر شیییمیا ظیاهر 

و یا   "Excel گزررش"،   "HTML گزررش"رکنو  با رن خاب هر یک رز دکمه های   .شیوند

برخی عنیاوین رن خیاب  . ، گزررش رر در قیاعیب مورد نرر خود درییافیت خورهوید کرد"نمودرر"

در   رورز رین  رند،به جای تاریم خورشیودی بر رسیا  تاریم مولادی مقدررگذرری شیده  شیده،

که ترکو ی رز عناوین خورشیودی و مولادی رر برگزیده باشیود، با رن خاب هر یک   صیورتی

های خورشییودی و مولادی باز رز دکمه های زیر دو صییفحه برری نمایش گزررش در تاریم

روند م غورهای رن خاب شیده در دوره   "نمودرر"وک بر روی . به عنور  مثال با کلشیوندمی

 شودمورد نرر ظاهر می

 جستجوی عناوین اطلاعاتی 

جع ه کوپکی برری وررد کرد  ع ارت مورد جتی جوی کاربر    "جتی جو"با کلوک دکمه   

  .شیییود. ع ارت مورد نرر خود رر وررد کرده و دکمه جتییی جو رر رن خاب کنود پدیدرر می

شییود در کادر سییمت ررسییت به همه عناوینی که ع ارت مورد نرر شییما در آنها یافت می

هایی که عنور  مزبور رز آنها ون هر عنور  شییاخهپای. شییوندترتوب حروف رعف ا عوتییت می

رند تا کاربر رز جایااه دقوق هر عنور  در سیاخ ار رطلاعات آگاهی  مری ق شیده در  شیده

که عنورنی حاوی مقدرر عددی باشیید علاوه بر رینکه سییمت ررسییت آ    یابد. در صییورتی

شود که در  می  "ابرن خ"روی عنور  دکمه  هشود، روبظاهر میپوکانی قرمز رنگ   تصیویر

شییود رفزوده می  "عناوین برگزیده"با رن خاب رین دکمه، عنور  مربوطه به عوتییت پنجره  

  "فرردرده "همه عناوین عوتیت شیده دررری دکمه  زیر(  )پنجره پائون سیمت پ  در شیکل  

هتی ند، که با رن خاب رین دکمه فرردرده مرت ن با موضیوی در پنجره فرردرده نمایش درده  

 10که ن وجه جتی جو بوری ر رز   در صیورتی زیر(.)پنجره بالا سیمت پ  در شیکل  شیود  می
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در    "صییفحه بعد"مورد باشیید بقوه عناوین در صییفحات بعد نمایش درده مورییوند، دکمه  

سیمت پ   .دهدرن های کادر سیمت ررسیت، دیار صیفحات دسی اورد جتی جو رر نمایش می

د که برری دریافت آگاهی بور ر به  قررر درر  "جتی جوی پوررف ه"پووند    "جتی جو"دکمه  

 )مطابق شکل زیر(.  مررجعه کنود  "جت جوی پوررف ه عناوین رطلاعاتی"بخش

 

 جستجوی پیشرفته عناوین اطلاعات

جع ه کوپکی برری وررد کرد  ع ارت مورد جتیی جوی کاربر    "جتیی جو"با کلوک دکمه  

  "وی پوریرف ه جتی ج"پووند   "جتی جو"(. سیمت پ  دکمه  زیرشیود )شیکل  پدیدرر می

رین فرم  .  شیودمیمطابق شیکل زیر قررر دررد که با رن خاب آ  فرم جتی جوی پوریرف ه باز  

تر مورد جتی جو قررر دهود. عوتیت  دهد عناوین مورد نرر خود رر دقوقبه شیما رجازه می

دهد که جت جو رر تنها در عناوینی  به کاربر رمکا  می "سال شروی"های  و عوتت "تورتر"

هد که تورتری مریخ  دررند و یا سیال شیروی آمارگوری آنها در بازه خاصیی قررر  رنجام د

کند.  عوتیت دیاری وجود دررد که نحوه جتی جوی کلمات در  شیده رر مریخ  می.  دررد
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.  "همه کلمات"و    "هر یک رز کلمات"،  "عون ع ارت"رین عوتیت شیامل رین موررد رسیت:  

تی جو مریابه جتی جوی سیاده خورهد بود.  رن خاب شیود ن وجه ج  "عون ع ارت"رگر گزینه  

رر رن خاب کنود، همه عناوینی که حدرقل یکی    "هر یک رز کلمات"که مورد    در صیییورتی

 :نااه کنود  زیرشوند. به شکل  رز کلمات مورد نرر شما رر دررر باشند عوتت می

 

ر یک  ه"رر در جع ه جتیی جو وررد کرده و گزینه    "پول بانک "در رین مورد کاربر ع ارت   

و   "پول"رر برگزیده رسیت. با فریرد  دکمه جتی جو همه عناوینی که یا کلمه    "رز کلمات

  "همه کلمات "در صییورت رن خاب گزینه   .رندو یا هر دو رر دررند  عوتییت شییده  "بانک "یا  

ها موجود شییوند که همه کلمات مورد نرر شییما در سییاخ ار آ تنها عناوینی عوتییت می

ها در ساخ ار آ   "بانک "و ه  کلمه    "پول"د عناوینی که ه  کلمه  در رین مور باشد. مثلاً

پس رز .  شیییوندوجود دررد بدو  در نرر کرف ن ترتویب یا جایایاه رین کلمیات عوتیییت می

همه عناوین یافت شیده در کادر سیمت ررسیت به ترتوب حروف   "جتی جو"فریرد  دکمه  
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  مزبور رز آنها مری ق شده در   هایی که عنورایون هر عنور  شیاخه. پشیوندرعف ا عوتیت می

که   رند تا کاربر رز جایااه دقوق هر عنور  در سیاخ ار رطلاعات آگاهی یابد. در صیورتیشیده

ظاهر   عنورنی حاوی مقدرر عددی باشیید علاوه بر رینکه سییمت ررسییت آ  تصییویر  

 شییود که با رن خاب رین دکمه، عنور در  می  "رن خاب"روی عنور  دکمه  هشییود، روبمی

در  شیود )پنجره پائون سیمت پ  رفزوده می "عناوین برگزیده"مربوطه به عوتیت پنجره  

هتی ند، که با رن خاب رین   "فرردرده"همه عناوین عوتیت شیده دررری دکمه   شیکل بالا(.

دکمه فرردرده مرت ن با موضیوی در پنجره فرردرده نمایش درده موریود )پنجره بالا سیمت 

مورد باشد بقوه عناوین در   10که ن وجه جت جو بور ر رز    (. در صورتیدر شکل بالاپ  

در رن های کادر سیمت ررسیت،   "صیفحه بعد"شیوند، دکمه  صیفحات بعد نمایش درده می

پووند   "جتی جو"سیمت پ  دکمه  .  دهددیار صیفحات دسی اورد جتی جو رر نمایش می

جتیی جوی  "قررر دررد که برری دریافت آگاهی بوریی ر به بخش  "جتیی جوی پورییرف ه"

 مررجعه کنود" پوررف ه عناوین رطلاعاتی

 نحوه دانلود داده از بانک جهانی 

ترین من ع رررئیه دهنیده  درنلود درده رز بیانیک جهیانی بیه عنور  کیامیل  در رین بخش نحوه

 های رق صادی به صورت تصویری و مرحله به مرحله شرز درده خورهد شد. درده

 سایت بانک جهانی شوید:رب در رز طریق آدر  زیر وررد وب

www.data.worldbank.org 

 شود:ری به شکل زیر باز میپنجره

 



 11  ایویوز افزارنرم   اقتصادسنجی کاربردی پیشرفته با

 

176 

 

 

ی برری درنلود درده در رین قتیمت بررسیا ، کریور، موضیوی و یا شیاخ  متیورهای مخ لف 

ترین متییور که رمکا   ترین رره و در عون حال کاملمورد نرر وجود دررد. در ردرمه سییاده

 شود:دس رسی به کلوه کرورها و م غورها فرره  باشد توضوح درده می

 کنود:به صورت زیر کلوک    World Development Indicatorsبر روی 
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شییود که باید کرییور )کرییورهای( مورد نرر یا م غور )م غورهای مورد پنجره زیر باز می

 نرر( و دوره زمانی مورد نواز رن خاب شود:
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 Countryدر بخش  

 در رین بخش کرور و یا کرورهای مورد نواز برری مطاععه رر با زد  توک رن خاب کنود.

   Seriesدر بخش  

م غور برری هر کرییور موجود رسییت( رر   1000مورد نرر )که در رینجا حدود  م غورهای  

 رن خاب کنود

 Timeدر بخش  

 دوره زمانی مورد مطاععه رر رن خاب رر رن خاب کنود. 

رز تکمویل بخش رر مطیابق   Apply Changesهیای فو ، در همون پنجره گزینیه  پس 

 :وک کنودلشکل زیر ک
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 شود:ر باز میپس رز طی متور بالا، پنجره زی

 

هیای رن خیاب شیییده، کیافی رسیییت بر روی گزینیه  پس رز طی مررحیل بیالا برری درنلود درده

Download :در بخش بالا و سمت ررست صفحه، به صورت زیر کلوک کنود 
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 صورت رکتل دریافت کنود.با رن خاب گزینه رول، فایل درده رر به
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